Digital Still Camera
User's Guide/ Troubleshooting

DSC-W100

“Read This First” (separate volume)
Explains the set-up and basic operations for shooting/playback with your camera.

Operating Instructions
Before operating the unit, please read this manual and “Read This First” (separate volume) thoroughly, and retain it for future reference.

Owner's Record
The model and serial numbers are located on the bottom. Record the serial number in the space provided below. Refer to these numbers whenever you call upon your Sony dealer regarding this product.

Model No. DSC-W100
Serial No. ___________________________

Additional information on this product and answers to frequently asked questions can be found at our Customer Support Website.

http://www.sony.net/

Printed on 100% recycled paper using VOC (Volatile Organic Compound)-free vegetable oil based ink.

Printed in Japan

© 2006 Sony Corporation 2-674-788-11(1)
To reduce fire or shock hazard, do not expose the unit to rain or moisture.

For Customers in the U.S.A.

This symbol is intended to alert the user to the presence of uninsulated “dangerous voltage” within the product’s enclosure that may be of sufficient magnitude to constitute a risk of electric shock to persons.

This symbol is intended to alert the user to the presence of important operating and maintenance (servicing) instructions in the literature accompanying the appliance.
IMPORTANT SAFEGUARDS

For your protection, please read these safety instructions completely before operating the appliance, and keep this manual for future reference.

Carefully observe all warnings, precautions and instructions on the appliance, or the one described in the operating instructions and adhere to them.

**Use**

**Power Sources**

This set should be operated only from the type of power source indicated on the marking label. If you are not sure of the type of electrical power supplied to your home, consult your dealer or local power company. For those sets designed to operate from battery power, or other sources, refer to the operating instructions.

**Polarization**

This set may be equipped with a polarized ac power cord plug (a plug having one blade wider than the other).

This plug will fit into the power outlet only one way. This is a safety feature. If you are unable to insert the plug fully into the outlet, try reversing the plug. If the plug should still fail to fit, contact your electrician to have a suitable outlet installed.

Do not defeat the safety purpose of the polarized plug by forcing it in.

**Overloading**

Do not overload wall outlets, extension cords or convenience receptacles beyond their capacity, since this can result in fire or electric shock.

**Object and Liquid Entry**

Never push objects of any kind into the set through openings as they may touch dangerous voltage points or short out parts that could result in a fire or electric shock. Never spill liquid of any kind on the set.

**Attachments**

Do not use attachments not recommended by the manufacturer, as they may cause hazards.

**Cleaning**

Unplug the set from the wall outlet before cleaning or polishing it. Do not use liquid cleaners or aerosol cleaners. Use a cloth lightly dampened with water for cleaning the exterior of the set.

**Installation**

**Water and Moisture**

Do not use power-line operated sets near water – for example, near a bathtub, washbowl, kitchen sink, or laundry tub, in a wet basement, or near a swimming pool, etc.

**Power-Cord Protection**

Route the power cord so that it is not likely to be walked on or pinched by items placed upon or against them, paying particular attention to the plugs, receptacles, and the point where the cord exits from the appliance.

**Accessories**

Do not place the set on an unstable cart, stand, tripod, bracket, or table. The set may fall, causing serious injury to a child or an adult, and serious damage to the set. Use only a cart, stand, tripod, bracket, or table recommended by the manufacturer.

**Ventilation**

The slots and openings in the cabinet are provided for necessary ventilation. To ensure reliable operation of the set, and to protect it from overheating, these slots and openings must never be blocked or covered.

– Never cover the slots and openings with a cloth or other materials.
– Never block the slots and openings by placing the set on a bed, sofa, rug, or other similar surface.
– Never place the set in a confined space, such as a bookcase, or built-in cabinet, unless proper ventilation is provided.
– Do not place the set near or over a radiator or heat register, or where it is exposed to direct sunlight.
Lightning
For added protection for this set during a lightning storm, or when it is left unattended and unused for long periods of time, unplug it from the wall outlet and disconnect the antenna or cable system. This will prevent damage to the set due to lightning and power-line surges.

Safety Check
Upon completion of any service or repairs to the set, ask the service technician to perform routine safety checks (as specified by the manufacturer) to determine that the set is in safe operating condition.

Service

Damage Requiring Service
Unplug the set from the wall outlet and refer servicing to qualified service personnel under the following conditions:
- When the power cord or plug is damaged or frayed.
- If liquid has been spilled or objects have fallen into the set.
- If the set has been exposed to rain or water.
- If the set has been subject to excessive shock by being dropped, or the cabinet has been damaged.
- If the set does not operate normally when following the operating instructions. Adjust only those controls that are specified in the operating instructions. Improper adjustment of other controls may result in damage and will often require extensive work by a qualified technician to restore the set to normal operation.
- When the set exhibits a distinct change in performance – this indicates a need for service.

Servicing
Do not attempt to service the set yourself as opening or removing covers may expose you to dangerous voltage or other hazards.
Refer all servicing to qualified service personnel.

Replacement parts
When replacement parts are required, be sure the service technician has used replacement parts specified by the manufacturer that have the same characteristics as the original parts. Unauthorized substitutions may result in fire, electric shock, or other hazards.
Read this first

**CAUTION**

Replace the battery with the specified type only. Otherwise, fire or injury may result.

**For Customers in the U.S.A. and Canada**

**RECYCLING LITHIUM-ION BATTERIES**

Lithium-Ion batteries are recyclable.

You can help preserve our environment by returning your used rechargeable batteries to the collection and recycling location nearest you.

For more information regarding recycling of rechargeable batteries, call toll free 1-800-822-8837, or visit http://www.rbrc.org/

**Caution:** Do not handle damaged or leaking Lithium-Ion batteries.

**For Customers in the U.S.A.**

If you have any questions about this product, you may call:

Sony Customer Information Services Center
1-800-222-SONY (7669)

The number below is for the FCC related matters only.

**Regulatory Information**

**Declaration of Conformity**

Trade Name: SONY  
Model No.:DSC-W100  
Responsible Party: Sony Electronics Inc.  
Address: 16530 Via Esprillo, San Diego  
CA 92127 U.S.A  
Telephone number: 858-942-2230

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.
Note:
This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:
– Reorient or relocate the receiving antenna.
– Increase the separation between the equipment and receiver.
– Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
– Consult the dealer or an experienced radio/TV technician for help.

The supplied interface cable must be used with the equipment in order to comply with the limits for a digital device pursuant to Subpart B of Part 15 of FCC Rules.

For Customers in Europe
This product has been tested and found compliant with the limits set out in the EMC Directive for using connection cables shorter than 3 meters (9.8 feet).

Attention
The electromagnetic fields at the specific frequencies may influence the picture and sound of this camera.

Notice
If static electricity or electromagnetism causes data transfer to discontinue midway (fail), restart the application or disconnect and connect the communication cable (USB, etc.) again.

Disposal of Old Electrical & Electronic Equipment (Applicable in the European Union and other European countries with separate collection systems)

This symbol on the product or on its packaging indicates that this product shall not be treated as household waste. Instead it shall be handed over to the applicable collection point for the recycling of electrical and electronic equipment. By ensuring this product is disposed of correctly, you will help prevent potential negative consequences for the environment and human health, which could otherwise be caused by inappropriate waste handling of this product. The recycling of materials will help to conserve natural resources.

For more detailed information about recycling of this product, please contact your local Civic Office, your household waste disposal service or the shop where you purchased the product.

Notice for customers in the United Kingdom
A moulded plug complying with BS 1363 is fitted to this equipment for your safety and convenience. Should the fuse in the plug supplied need to be replaced, a fuse of the same rating as the supplied one and approved by ASTA or BSI to BS 1362, (i.e., marked with an ⚡ or ⚡️ mark) must be used.

If the plug supplied with this equipment has a detachable fuse cover, be sure to attach the fuse cover after you change the fuse. Never use the plug without the fuse cover. If you should lose the fuse cover, please contact your nearest Sony service station.
Notes on using your camera

Types of “Memory Stick” that can be used (not supplied)
The IC recording medium used by this camera is a “Memory Stick Duo”. There are two types of “Memory Stick”.

“Memory Stick Duo”: you can use a “Memory Stick Duo” with your camera.

“Memory Stick”: you cannot use a “Memory Stick” with your camera.

Other memory cards cannot be used.
- For details on “Memory Stick Duo”, see page 97.

When using a “Memory Stick Duo” with “Memory Stick” compatible equipment
You can use the “Memory Stick Duo” by inserting it into the Memory Stick Duo Adaptor (not supplied).

Notes on the battery pack
- Charge the battery pack (supplied) before using the camera for the first time. (→ step 1 in “Read This First”)
- The battery pack can be charged even if it is not completely discharged. Also, even if the battery pack is not fully charged, you can use the partially charged capacity of the battery pack as is.
- If you do not intend to use the battery pack for a long time, use up the existing charge and remove it from your camera, then store it in a cool, dry place. This is to maintain the battery pack functions (page 99).
- For details on the usable battery pack, see page 99.

Carl Zeiss lens
This camera is equipped with a Carl Zeiss lens which is capable of reproducing sharp images with excellent contrast. The lens for this camera has been produced under a quality assurance system certified by Carl Zeiss in accordance with the quality standards of Carl Zeiss in Germany.

No compensation for contents of the recording
- The contents of the recording cannot be compensated for if recording or playback is not possible due to a malfunction of your camera or recording media, etc.

Internal memory and “Memory Stick Duo” back up
- Do not turn off the camera or remove the battery pack or “Memory Stick Duo” while the access lamp is lighted, as the internal memory data or “Memory Stick Duo” data may be destroyed. Always protect your data by making a back up copy. See page 27 for the data back up method.

Notes on recording/playback
- This camera is neither dust-proof, nor splash-proof, nor water-proof. Read “Precautions” (page 101) before operating the camera.
- Before you record one-time events, make a trial recording to make sure that the camera is working correctly.
- Be careful not to get the camera wet. Water entering the inside of the camera may cause malfunctions which in some cases may not be repairable.
- Do not aim the camera at the sun or other bright light. This may cause irrecoverable damage to your eyes. Or it may cause the malfunction of your camera.
- Do not use the camera near a location that generates strong radio waves or emits radiation. The camera may not be able to record or play back properly.
• Using the camera in sandy or dusty locations may cause malfunctions.
• If moisture condensation occurs, remove it before using the camera (page 101).
• Do not shake or strike the camera. In addition to malfunctions and an inability to record images, this may render the recording medium unusable, or cause image data breakdown, damage or loss.
• Clean the flash surface before use. The heat of flash emission may cause dirt on the flash surface to become discolored or to stick to the flash surface, resulting in insufficient light emission.

Notes on the LCD screen and lens
• The LCD screen is manufactured using extremely high-precision technology so over 99.99% of the pixels are operational for effective use. However, there may be some tiny black points and/or bright points (white, red, blue or green in color) that constantly appear on the LCD screen. These points are normal in the manufacturing process and do not affect the recording in any way.

Exposing the LCD screen or the lens to direct sunlight for long periods may cause malfunctions. Be careful when placing the camera near a window or outdoors.
• Do not press against the LCD screen. The screen may be discolored and that may cause a malfunction.
• Images may trail across on the LCD screen in a cold location. This is not a malfunction.
• This camera is equipped with a power zoom lens. Be careful not to bump the lens, and be careful not to apply force to it.

On image data compatibility
• This camera conforms with DCF (Design rule for Camera File system) universal standard established by JEITA (Japan Electronics and Information Technology Industries Association).
• Playback of images recorded with your camera on other equipment and playback of images recorded or edited with other equipment on your camera are not guaranteed.

Warning on copyright
Television programs, films, videotapes, and other materials may be copyrighted. Unauthorized recording of such materials may be contrary to the provisions of the copyright laws.

The pictures used in this manual
The photographs used as examples of pictures in this manual are reproduced images, and are not actual images shot using this camera.
For full use of the digital still camera

Prepare the camera and shoot images easily

“Read This First” (separate volume)
1 Prepare the battery pack
2 Turn the camera on/set the clock
3 Insert a “Memory Stick Duo” (not supplied)
4 Select the image size for use
5 Shoot images easily (Auto adjustment mode)
   Shoot still images (Scene Selection)
6 View/delete images

Get more friendly with your camera

- Shoot with your favorite settings (Program auto shooting/
  Manual shooting) → page 29
- Enjoy various shooting/playback using the menu → page 32
- Change the default settings → page 48

Connect your camera to a PC or a printer

- Copy your images to a computer and enjoy editing them in
  various ways → page 58
- Print images by connecting your camera directly to a printer
  (PictBridge compliant printers only) → page 75
Table of contents

Read this first .................................................................................................................. 5
Notes on using your camera ................................................................. 7

Enjoying the camera

Basic techniques for better images ................................................................. 13
  Focus – Focusing on a subject successfully ................................................. 13
  Exposure – Adjusting the light intensity ....................................................... 14
  Color – On the effects of lighting ................................................................. 16
  Quality – On “image quality” and “image size” ............................................ 16
Identifying parts ......................................................................................... 18
Indicators on the screen ............................................................................ 20
Changing the screen display ................................................................. 24
Number of still images and recording time of movies ......................... 25
When you do not have a “Memory Stick Duo” (Recording with the internal memory) ................................................................. 27
Battery life and number of images that can be recorded/viewed .......... 28
Using the mode dial ................................................................................. 29

Using the menu

Using menu items ......................................................................................... 32
Menu items .............................................................................................. 33
Shooting menu .......................................................................................... 34
  COLOR (Color Mode)
  (Focus)
  (Metering Mode)
  WB (White Bal)
  ISO
  (P.Quality)
  Mode (REC Mode)
  (Interval)
  (Flash Level)
  (Contrast)
  (Sharpness)
  (Setup)
Viewing menu
- (Folder)
- (Protect)
DPOF
- (Print)
- (Slide)
- (Resize)
- (Rotate)
- (Divide)
- (Setup)
Trimming

Using the Setup screen

Using Setup items

\[ \text{Camera} \] \text{AF Mode} \text{Digital Zoom} \text{Function Guide} \text{Red Eye Reduction} \text{AF Illuminator} \text{Auto Review} \]

\[ \text{Internal Memory Tool} \] \text{Format} \]

\[ \text{Memory Stick Tool} \] \text{Format} \text{Create REC. Folder} \text{Change REC. Folder} \text{Copy} \]

\[ \text{Setup 1} \] \text{LCD Backlight} \text{Beep} \text{Language} \text{Initialize} \]

\[ \text{Setup 2} \] \text{File Number} \text{USB Connect} \text{Video Out} \text{Clock Set} \]
This section describes the basics so you can enjoy your camera. It tells you how to use various camera functions such as the mode dial (page 29), the menus (page 32), and so on.

**Focus**

**Focusing on a subject successfully**

When you press the shutter button halfway down, the camera adjusts the focus automatically (Auto Focus). Remember to press the shutter button only halfway down.

- Press the shutter button fully down straight away.
- Press the shutter button halfway down.
- AE/AF lock indicator Flashing → lit/beeps
- Then press the shutter button fully down.

To shoot a still image difficult to focus on → [Focus] (page 35)

If the image looks blurred even after focusing, it may be because of camera shake. → See “Hints for preventing blur” (as follows).

**Hints for preventing blur**

Hold the camera steadily, keeping your arms at your side. Also, you can stabilize the camera by leaning against a tree or a building beside you. Using the 2-second delay self-timer or a tripod may be effective. Also, using the flash in dark places is also recommended.
Exposure Adjusting the light intensity

You can create various images by adjusting the exposure and the ISO sensitivity. Exposure is the amount of light that the camera will receive when you release the shutter.

Exposure:
- **Shutter speed** = Length of time the camera receives light
- **Aperture** = Size of the opening allowing light to pass through
- **ISO** = Recording sensitivity

Overexposure = too much light
Whitish image

Correct exposure

Underexposure = too little light
Darker image

The exposure is automatically set to the proper value in the auto adjustment mode. However, you can adjust it manually using the functions below.

**Manual exposure:**
Allows you to adjust the shutter speed and aperture value manually. → page 30

**Adjusting EV:**
Allows you to adjust the exposure that has been determined by the camera.
→ step 5 in “Read This First”, page 15

**Metering Mode:**
Allows you to change the part of the subject to be measured to determine the exposure. → page 36

### Characteristics of “shutter speed”
- **Faster**
  - Moving objects appear stopped.

- **Slower**
  - Moving objects appear to flow.

### Characteristics of “aperture” (F value)
- **Open**
  - In-focus range narrows, both backward and forward.

- **Close**
  - In-focus range widens, both backward and forward.
Hints for adjusting the exposure (EV)

When shooting a whitish overall image such as a backlit subject or a snowy scene

The camera judges that the subject is bright so that the exposure is darker.

Adjust in the + direction

When shooting a darker overall image

The camera judges that the subject is dark so that the exposure is brighter.

Adjust in the – direction

You can check the exposure referring to the histogram chart. Be careful not to overexpose or underexpose your subject (giving a whitish or darkish image) (page 24, → step 5 in “Read This First”).

Adjusting the ISO sensitivity

ISO is unit of measurement (sensitivity), estimating how much light an image pickup device (equivalent to photo films) receives. Even when the exposure is the same, images differ depending on the ISO sensitivity.
To adjust the ISO sensitivity → page 37

High ISO sensitivity
Records a bright image even when shooting in a dark location.
However, the image tends to become noisy.

Low ISO sensitivity
Records a smoother image.
However, when the exposure is insufficient, the image may become darker.
Color

On the effects of lighting

The apparent color of the subject is affected by the lighting conditions.

Example: The color of an image affected by light sources

<table>
<thead>
<tr>
<th>Weather/lighting</th>
<th>Daylight</th>
<th>Cloudy</th>
<th>Fluorescent</th>
<th>Incandescent</th>
</tr>
</thead>
<tbody>
<tr>
<td>Characteristics of light</td>
<td>White (standard)</td>
<td>Bluish</td>
<td>Blue-tinged</td>
<td>Reddish</td>
</tr>
</tbody>
</table>

The color tones are adjusted automatically in the auto adjustment mode. However, you can adjust color tones manually with [White Bal] (page 37).

Quality

On “image quality” and “image size”

A digital image is made up of a collection of small dots called pixels. If it contains a large number of pixels, the picture becomes large, it takes up more memory, and the image is displayed in fine detail. “Image size” is shown by the number of pixels. Although you cannot see the differences on the screen of the camera, the fine detail and data processing time differ when the image is printed or displayed on a computer screen.

Description of the pixels and the image size

1. Image size: 8M
   3,264 pixels × 2,448 pixels = 7,990,272 pixels

2. Image size: VGA
   640 pixels × 480 pixels = 307,200 pixels
Selecting the image size for use (→ step 4 in “Read This First”)

The default settings are marked with ✔.

<table>
<thead>
<tr>
<th>Image size</th>
<th>Usage guidelines</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔ 8M (3264×2448)</td>
<td>Larger</td>
</tr>
<tr>
<td>3:2 1) (3264×2176)</td>
<td>Match 3:2 Aspect Ratio</td>
</tr>
<tr>
<td>5M (2592 × 1944)</td>
<td>Up to A4/8×10”print</td>
</tr>
<tr>
<td>3M (2048×1536)</td>
<td>Up to 13×18cm/5×7”print</td>
</tr>
<tr>
<td>2M (1632×1224)</td>
<td>Up to 10×15cm/4×6”print</td>
</tr>
<tr>
<td>VGA (640×480)</td>
<td>For E-mail</td>
</tr>
<tr>
<td>16:9 2) (1920×1080)</td>
<td>Display On 16:9 HDTV 3)</td>
</tr>
</tbody>
</table>

1) Images are recorded in the same 3:2 aspect ratio as photograph printing paper or postcards, etc.
2) Both edges of the image may be cut off when printing (page 91).
3) By using a Memory Stick slot or USB connection, you can enjoy higher quality images.

<table>
<thead>
<tr>
<th>Movie image size</th>
<th>Frame/Second</th>
<th>Usage guidelines</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔ 640(Fine) (640×480)</td>
<td>Approx. 30</td>
<td>Display on TV (high quality)</td>
</tr>
<tr>
<td>640(Standard) (640×480)</td>
<td>Approx. 17</td>
<td>Display on TV (standard)</td>
</tr>
<tr>
<td>160 (160×112)</td>
<td>Approx. 8</td>
<td>For E-mail</td>
</tr>
</tbody>
</table>

- The larger the image size, the higher the quality is.
- The more frames per second you played back, the smoother playback can be.

Selecting the image quality (compression ratio) in combination (page 38)

You can select the compression ratio when digital images are saved. When you select a high compression ratio, the image lacks the fineness of detail, but has a smaller file size.
Identifying parts

See the pages in parentheses for details of operation.

1 | Shutter button (→ step 5 in “Read This First”)  
2 | For shooting: Zoom (W/T) lever  
   | (→ step 5 in “Read This First”)  
   | For viewing:  (Playback zoom)  
   | lever/ (Index) lever (→ step 6 in “Read This First”)  
3 | Microphone  
4 | Self-timer lamp (→ step 5 in “Read This First”)/AF illuminator (51)  
5 | Lens  
6 | POWER button/POWER lamp (→ step 2 in “Read This First”)  
7 | Flash (→ step 5 in “Read This First”)  
8 | Finder window

1 | AE/AF lock lamp/Self-timer lamp  
   | (green) (→ step 5 in “Read This First”)  
2 | Flash charging lamp/Record lamp  
   | (orange) (→ step 5 in “Read This First”)  
3 | Finder (→ step 5 in “Read This First”)  
4 | LCD screen (24)  
5 | (Screen display switch) button (24)  
6 | MENU button (32)  
7 | Speaker
8 (Playback) button (→ step 6 in “Read This First”)
9 DC IN jack cover
10 DC IN jack
 When using an AC-LS5K AC Adaptor (not supplied)
 For details, refer to the operation manual supplied with the AC adaptor.

17 Tripod receptacle (bottom)
 - Use a tripod with a screw length of less than 5.5 mm (7/32 inch). You will be unable to
   firmly secure the camera to tripods having screws longer than 5.5 mm (7/32 inch), and
   may damage the camera.
 - After use, remove the camera from the tripod.

18 Battery/“Memory Stick Duo” cover (→ step 1 and 3 in “Read This First”)

19 Access lamp (→ step 4 in “Read This First”)

20 “Memory Stick Duo” slot
 (→ step 3 in “Read This First”)

21 Battery insertion slot
 (→ step 1 in “Read This First”)

22 Battery eject lever
 (→ step 1 in “Read This First”)

11 Mode dial (29)

12 Hook for wrist strap (→ “Read This First”)

13 Control button
 Menu on: ▲▼◄► ○ (→ step 2 in “Read This First”)
 Menu off: ◀◁○□□ (→ step 5 in “Read This First”)

14 / (Image Size/Delete) button
 (→ step 4 and 6 in “Read This First”)

15 Multi connector cover

16 Multi connector
Indicators on the screen

See the pages in parentheses for details of operation.

When shooting still images

When shooting movies

<table>
<thead>
<tr>
<th>Display</th>
<th>Indication</th>
</tr>
</thead>
<tbody>
<tr>
<td>📸</td>
<td>Camera mode (→ step 5 in “Read This First”)</td>
</tr>
<tr>
<td>⚡️ ⚡️ SL</td>
<td>Flash mode (→ step 5 in “Read This First”)</td>
</tr>
<tr>
<td>⚡️</td>
<td>Flash charging</td>
</tr>
<tr>
<td>⚡️</td>
<td>Zoom scaling (→ 49, step 5 in “Read This First”)</td>
</tr>
<tr>
<td>🕵️</td>
<td>Red-eye reduction (50)</td>
</tr>
<tr>
<td>✿</td>
<td>Sharpness (40)</td>
</tr>
<tr>
<td>✿</td>
<td>Contrast (40)</td>
</tr>
<tr>
<td>✿ ON</td>
<td>AF illuminator (51)</td>
</tr>
<tr>
<td>✿</td>
<td>Metering mode (36)</td>
</tr>
<tr>
<td>✿</td>
<td>Color mode (34)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Display</th>
<th>Indication</th>
</tr>
</thead>
<tbody>
<tr>
<td>🌺</td>
<td>Macro (→ step 5 in “Read This First”)</td>
</tr>
<tr>
<td>S AF</td>
<td>AF mode (49)</td>
</tr>
<tr>
<td>🕵️ 🕵️ 🕵️</td>
<td>AF range finder frame indicator (35)</td>
</tr>
<tr>
<td>1.0m</td>
<td>Focus preset distance (35)</td>
</tr>
<tr>
<td>🌺</td>
<td>Exposure value scale bar (→ step 5 in “Read This First”)</td>
</tr>
<tr>
<td>🌺 🌺 🌺</td>
<td>Exposure value guide (→ step 5 in “Read This First”)</td>
</tr>
</tbody>
</table>

1. Battery remaining (→ step 1 in “Read This First”)  
2. AE/AF lock (→ step 5 in “Read This First”)  
3. Recording mode (29, 38)  
4. White balance (37)  
5. Standby/Recording a movie (→ step 5 in “Read This First”)  
6. Mode dial (Scene Selection) (→ step 5 in “Read This First”)  
7. Mode dial (29)
### Display Indication

<table>
<thead>
<tr>
<th>Display</th>
<th>Indication</th>
</tr>
</thead>
</table>
| ![Image Size](image.png) | Image size (→ step 4 in “Read This First”)  
- is displayed only when the Multi Burst is activated. |
| ![Fine Standard](image.png) | Image quality (38) |
| ![Remaining Internal Memory](image.png) | Recording folder (53)  
- This does not appear when using internal memory. |
| ![Remaining Memory Stick](image.png) | Remaining internal memory capacity (25) |
| ![Remaining “Memory Stick” Capacity](image.png) | Remaining “Memory Stick” capacity (25) |
| ![Recording Time](image.png) | Recording time [maximum recordable time] (26) |
| ![Multi Burst Interval](image.png) | Multi Burst interval (40) |
| ![Remaining Number of Recordable Images](image.png) | Remaining number of recordable images (25) |
| ![Self-Timer](image.png) | Self-timer (→ step 5 in “Read This First”) |
| ![ISO Number](image.png) | ISO number (37) |
| ![Vibration Warning](image.png) | Vibration warning (13)  
- Indicates vibration may prevent you from shooting clear images due to insufficient lighting. Even if the vibration warning appears, you can still shoot images. However, we recommend that you use the flash for better lighting or using a tripod or other means to stabilize the camera. |
| ![Low Battery Warning](image.png) | Low battery warning (28, 94) |
| ![Spot Metering Cross Hair](image.png) | Spot metering cross hair (36) |
| ![AF Range Finder Frame](image.png) | AF range finder frame (35) |
| ![Histogram](image.png) | Histogram (24) |
| ![NR Slow Shutter](image.png) | NR slow shutter (31)  
- When using certain shutter speeds*, the NR slow shutter function activates automatically to reduce the picture noise.  
* When the shutter speed is equal to one second or slower. |
| ![Shutter Speed](image.png) | Shutter speed |
| ![Aperture Value](image.png) | Aperture value |
| ![Exposure Value](image.png) | Exposure Value (→ step 5 in “Read This First”) |
| ![Menu](image.png) | Menu (32) |

### Notes
- *When the shutter speed is equal to one second or slower.*
### When playing back still images

![Still Image Display](image)

### When playing back movies

![Movie Display](image)

<table>
<thead>
<tr>
<th>Display</th>
<th>Indication</th>
</tr>
</thead>
<tbody>
<tr>
<td>📋</td>
<td>Battery remaining (→ step 1 in “Read This First”)</td>
</tr>
<tr>
<td>📱</td>
<td>Recording mode (29, 38)</td>
</tr>
<tr>
<td>📈</td>
<td>Image size (→ step 4 in “Read This First”)</td>
</tr>
<tr>
<td>🎥</td>
<td>Playback mode (→ step 6 in “Read This First”)</td>
</tr>
<tr>
<td>🎯</td>
<td>Protect (42)</td>
</tr>
<tr>
<td>🗂️</td>
<td>Print order (DPOF) mark (78)</td>
</tr>
<tr>
<td>✂️</td>
<td>Change folder (41)</td>
</tr>
<tr>
<td>✂️</td>
<td>This does not appear when using internal memory.</td>
</tr>
<tr>
<td>×1.3</td>
<td>Zoom scaling (→ step 6 in “Read This First”)</td>
</tr>
<tr>
<td>Step 12/16</td>
<td>Frame by frame playback (38)</td>
</tr>
<tr>
<td>▶️</td>
<td>Playback (→ step 6 in “Read This First”)</td>
</tr>
<tr>
<td>VOL.</td>
<td>Volume (→ step 6 in “Read This First”)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Display</th>
<th>Indication</th>
</tr>
</thead>
<tbody>
<tr>
<td>101-0012</td>
<td>Folder-file number (41)</td>
</tr>
<tr>
<td></td>
<td>Playback bar (→ step 6 in “Read This First”)</td>
</tr>
</tbody>
</table>
### Enjoying the camera

#### Display and Indication

<table>
<thead>
<tr>
<th>Display</th>
<th>Indication</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="PictBridge" /></td>
<td>PictBridge connecting (76)</td>
</tr>
</tbody>
</table>
| ![Recording](image) | Recording folder (53)  
  - This does not appear when using internal memory. |
| ![Playback](image) | Playback folder (41)  
  - This does not appear when using internal memory. |
| ![RemainingInternal](image) | Remaining internal memory capacity (25) |
| ![RemainingMemory](image) | Remaining “Memory Stick” capacity (25) |
| **Date/Time** | Image number/Number of images recorded in selected folder |
| ![Counter](image) | Counter (→ step 6 in “Read This First”) |
| ![Self-diagnosis](image) | Self-diagnosis display (94) |
| ![Counter](image) | Counter (→ step 6 in “Read This First”) |

### Display and Indication

<table>
<thead>
<tr>
<th>Display</th>
<th>Indication</th>
</tr>
</thead>
</table>
| ![Histogram](image) | Histogram (24)  
  - [ ] appears when histogram display is disabled. |
| ![RecordedDate](image) | Recorded date/time of the playback image |
| ![Menu](image) | Menu (32) |
| ![Pause](image) | Playing back Multi Burst images in series (38) |
| ![Play](image) | Select images |
| ![Volume](image) | Adjust volume |

### Display and Indication

<table>
<thead>
<tr>
<th>Display</th>
<th>Indication</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Date/Time" /></td>
<td>Image number/Number of images recorded in selected folder</td>
</tr>
<tr>
<td><img src="image" alt="Counter" /></td>
<td>Counter (→ step 6 in “Read This First”)</td>
</tr>
<tr>
<td><img src="image" alt="Self-diagnosis" /></td>
<td>Self-diagnosis display (94)</td>
</tr>
</tbody>
</table>

### Display and Indication

<table>
<thead>
<tr>
<th>Display</th>
<th>Indication</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="ISO" /></td>
<td>ISO number (37)</td>
</tr>
<tr>
<td><img src="image" alt="Metering" /></td>
<td>Metering mode (36)</td>
</tr>
<tr>
<td><img src="image" alt="Flash" /></td>
<td>Flash</td>
</tr>
<tr>
<td><img src="image" alt="WhiteBalance" /></td>
<td>White balance (37)</td>
</tr>
<tr>
<td><img src="image" alt="ShutterSpeed" /></td>
<td>Shutter speed</td>
</tr>
<tr>
<td><img src="image" alt="ApertureValue" /></td>
<td>Aperture value</td>
</tr>
<tr>
<td><img src="image" alt="Playback" /></td>
<td>Playback image (→ step 6 in “Read This First”)</td>
</tr>
</tbody>
</table>
Changing the screen display

Each time you press the (Screen display switch) button, the display changes as follows.

- **Histogram on**
- **Indicators off**
- **LCD screen off**
- **Indicators on**

- By pressing (Screen display switch) button longer, you can brighten the LCD backlight. → *step 5 in “Read This First”*
- When you set the histogram display to on, image information is displayed during playback.
- The histogram does not appear in the following situations:
  - While shooting
    - When the menu is displayed.
    - When recording movies
  - During playback
    - When the menu is displayed.
    - In index mode
    - When you are using playback zoom.
    - When you are rotating still images.
    - During playback of movies
- During image playback, you cannot turn the LCD screen off.
- A large difference in the histogram displayed when shooting and during playback may occur when:
  - The flash strobes.
  - The shutter speed is slow or high.
- The histogram may not appear for images recorded using other cameras.
- When you set the LCD screen to off, the digital zoom does not function (page 49) and [AF Mode] is set to [Single] (page 49). When you select (flash mode)/ (self-timer)/ (macro), the image is displayed for about two seconds.

Using a histogram

A histogram is a graph showing the brightness of an image. Press (Screen display switch) repeatedly to display the histogram inside the screen. The graph display indicates a bright image when skewed to the right side, and a dark image when skewed to the left side. Set the mode dial to , , or Scene Selection, then adjust the exposure while checking it with the histogram (→ *step 5 in “Read This First”*).

- **A** Number of pixels
- **B** Brightness

The histogram also appears when the mode dial is set to M or when playing back a single image, but you cannot adjust the exposure.
Number of still images and recording time of movies

The tables show the approximate number of still images and the length of time for movies that can be recorded on a “Memory Stick Duo” formatted with this camera. The values may vary depending on the shooting conditions. For image size and image quality, see step 4 in “Read This First” and page 16.

The number of still images (The image quality is [Fine] on the upper line and [Standard] on the lower line.)

<table>
<thead>
<tr>
<th>Capacity</th>
<th>32MB</th>
<th>64MB/ Internal memory</th>
<th>128MB</th>
<th>256MB</th>
<th>512MB</th>
<th>1GB</th>
<th>2GB</th>
</tr>
</thead>
<tbody>
<tr>
<td>8M</td>
<td>8</td>
<td>16</td>
<td>32</td>
<td>59</td>
<td>121</td>
<td>247</td>
<td>506</td>
</tr>
<tr>
<td></td>
<td>15</td>
<td>30</td>
<td>60</td>
<td>109</td>
<td>223</td>
<td>456</td>
<td>934</td>
</tr>
<tr>
<td>3:2</td>
<td>8</td>
<td>16</td>
<td>32</td>
<td>59</td>
<td>121</td>
<td>247</td>
<td>506</td>
</tr>
<tr>
<td></td>
<td>15</td>
<td>30</td>
<td>60</td>
<td>109</td>
<td>223</td>
<td>456</td>
<td>934</td>
</tr>
<tr>
<td>5M</td>
<td>12</td>
<td>25</td>
<td>51</td>
<td>92</td>
<td>188</td>
<td>384</td>
<td>789</td>
</tr>
<tr>
<td></td>
<td>23</td>
<td>48</td>
<td>96</td>
<td>174</td>
<td>354</td>
<td>723</td>
<td>1482</td>
</tr>
<tr>
<td>3M</td>
<td>20</td>
<td>41</td>
<td>82</td>
<td>148</td>
<td>302</td>
<td>617</td>
<td>1266</td>
</tr>
<tr>
<td></td>
<td>37</td>
<td>74</td>
<td>149</td>
<td>264</td>
<td>537</td>
<td>1097</td>
<td>2250</td>
</tr>
<tr>
<td>2M</td>
<td>33</td>
<td>66</td>
<td>133</td>
<td>238</td>
<td>484</td>
<td>988</td>
<td>2025</td>
</tr>
<tr>
<td></td>
<td>61</td>
<td>123</td>
<td>246</td>
<td>446</td>
<td>907</td>
<td>1852</td>
<td>3798</td>
</tr>
<tr>
<td>VGA</td>
<td>196</td>
<td>394</td>
<td>790</td>
<td>1428</td>
<td>2904</td>
<td>5928</td>
<td>12154</td>
</tr>
<tr>
<td></td>
<td>491</td>
<td>985</td>
<td>1975</td>
<td>3571</td>
<td>7261</td>
<td>14821</td>
<td>30385</td>
</tr>
<tr>
<td>16:9</td>
<td>33</td>
<td>66</td>
<td>133</td>
<td>238</td>
<td>484</td>
<td>988</td>
<td>2025</td>
</tr>
<tr>
<td></td>
<td>61</td>
<td>123</td>
<td>246</td>
<td>446</td>
<td>907</td>
<td>1852</td>
<td>3798</td>
</tr>
</tbody>
</table>

- The number of images listed is for when [Mode] is set to [Normal].
- When the number of remaining shootable images is greater than 9,999, the “>9999” indicator appears.
- You can resize the images later ([Resize], page 44).
## The recording time of movies

(Units: hour : minute : second)

<table>
<thead>
<tr>
<th>Capacity</th>
<th>32MB</th>
<th>64MB/Internal memory</th>
<th>128MB</th>
<th>256MB</th>
<th>512MB</th>
<th>1GB</th>
<th>2GB</th>
</tr>
</thead>
<tbody>
<tr>
<td>640(Fine)</td>
<td>–</td>
<td>–</td>
<td>–</td>
<td>00:02:50</td>
<td>00:06:00</td>
<td>00:12:20</td>
<td>00:25:10</td>
</tr>
<tr>
<td>640(Standard)</td>
<td>00:01:20</td>
<td>00:02:50</td>
<td>00:05:50</td>
<td>00:10:40</td>
<td>00:21:40</td>
<td>00:44:20</td>
<td>01:31:00</td>
</tr>
<tr>
<td>160</td>
<td>00:22:40</td>
<td>00:45:30</td>
<td>01:31:30</td>
<td>02:51:20</td>
<td>05:47:00</td>
<td>11:44:20</td>
<td>24:18:20</td>
</tr>
</tbody>
</table>

- Movies with the size set to [640(Fine)] can only be recorded on a “Memory Stick PRO Duo”.

- When images recorded using earlier Sony models are played back on this camera, the display may differ from the actual image size.
When you do not have a “Memory Stick Duo” (Recording with the internal memory)

The camera has 64 MB of internal memory. This memory is not removable. Even when there is no “Memory Stick Duo” inserted in the camera, you can record images using this internal memory.

- Movies with the image size set to [640(Fine)] cannot be recorded using the internal memory.

When a “Memory Stick Duo” is inserted

[Recording]: Images are recorded on the “Memory Stick Duo”.
[Playback]: Images on the “Memory Stick Duo” are played back.
[Menu, Setup, etc.]: Various functions can be performed on images on the “Memory Stick Duo”.

When there is no “Memory Stick Duo” inserted

[Recording]: Images are recorded using the internal memory.
[Playback]: Images stored in the internal memory are played back.
[Menu, Setup, etc.]: Various functions can be performed on images in the internal memory.

On image data stored in the internal memory

We recommend that you copy (back up) data without fail using one of the following methods.

To copy (back up) data on a “Memory Stick Duo”

Prepare a “Memory Stick Duo” with a capacity of 64 MB or more, then perform the procedure explained in [Copy] (page 54).

To copy (back up) data on a hard disc of your computer

Perform the procedure on pages 61 to 63 without a “Memory Stick Duo” inserted in the camera.

- You cannot move image data on a “Memory Stick Duo” to the internal memory.
- You can copy data stored in the internal memory to a computer via a USB connection between a computer and your camera, but you cannot copy data on a computer to the internal memory.
Battery life and number of images that can be recorded/viewed

The tables show the approximate number of images that can be recorded/viewed and the battery life when you shoot images in [Normal] mode with the battery pack (supplied) at full capacity and at an ambient temperature of 25°C (77°F). The numbers of images that can be recorded or viewed take into account changing the “Memory Stick Duo” as necessary. Note that the actual numbers may be less than those indicated depending on the conditions of use.

- The battery capacity decreases as the number of uses increases and also over time (page 99).
- The number of images that can be recorded/viewed and the battery life are decreased under the following conditions:
  - The surrounding temperature is low.
  - The flash is used frequently.
  - The camera has been turned on and off many times.
  - The zoom is used frequently.
  - The brightness of LCD backlight is set to up.
  - [AF Mode] is set to [Monitor].
  - The battery power is low.

**When shooting still images**

<table>
<thead>
<tr>
<th>LCD screen</th>
<th>No. of images</th>
<th>Battery life (min.)</th>
</tr>
</thead>
<tbody>
<tr>
<td>On</td>
<td>Approx. 360</td>
<td>Approx. 180</td>
</tr>
<tr>
<td>Off</td>
<td>Approx. 410</td>
<td>Approx. 205</td>
</tr>
</tbody>
</table>

- Shooting in the following situations:
  - : (P.Quality) is set to [Fine].
  - [AF Mode] is set to [Single].
  - Shooting once every 30 seconds.
  - The zoom is switched alternately between the W and T ends.
  - The flash strobes once every two times.
  - The power turns on and off once every ten times.

- The measurement method is based on the CIPA standard.
  (CIPA: Camera & Imaging Products Association)
- The number of shooting images/battery life does not change, regardless of image size.

**When viewing still images**

<table>
<thead>
<tr>
<th>No. of images</th>
<th>Battery life (min.)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approx. 10600</td>
<td>Approx. 530</td>
</tr>
</tbody>
</table>

- Viewing single images in order at about three second intervals

**When shooting movies**

<table>
<thead>
<tr>
<th>LCD screen on (min.)</th>
<th>LCD screen off (min.)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approx. 180</td>
<td>Approx. 210</td>
</tr>
</tbody>
</table>

- Shooting movies continuously with an image size of [160]
Using the mode dial

Set the mode dial to the desired function.

Still image shooting modes

* : **Auto Adjustment mode**

Allows easy shooting with the settings adjusted automatically. \(\rightarrow\) step 5 in “Read This First”

P : **Program Auto mode**

Allows you to shoot with the exposure adjusted automatically (both the shutter speed and the aperture value). Also you can select various settings using the menu.

(For details on the functions available \(\rightarrow\) page 33)

M : **Manual exposure shooting mode**

Allows you to shoot after adjusting the exposure manually (both the shutter speed and the aperture value) (page 30).

Also, you can select the various settings using the menu.

(For details on the functions available \(\rightarrow\) page 33)

: **Scene Selection mode**

Allows you to shoot with preset settings according to the scene. \(\rightarrow\) step 5 in “Read This First”

In this Operating Instructions, the available mode dial setting is shown as follows.
Scene Selection
For details → step 5 in “Read This First”

For shooting an image appropriately according to the scene condition, a combination of functions is determined by the camera.

(✓: you can select the desired setting)

<table>
<thead>
<tr>
<th>Macro</th>
<th>Flash</th>
<th>AF range finder</th>
<th>Focus preset</th>
<th>White Balance</th>
<th>Flash level</th>
<th>Burst/Multi Burst</th>
</tr>
</thead>
<tbody>
<tr>
<td>✓</td>
<td>☑</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>—</td>
<td>✓</td>
</tr>
<tr>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>✓</td>
<td>☑</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>✓</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

To adjust the exposure manually

① Press ● on the control button when the mode dial is set to M. The “Set” indicator at the lower left of the screen changes to “Return,” and the camera enters the manual exposure setup mode.

② Adjust the settings using the control button.
   ◀▶: Aperture (F value)
   ▲▼: Shutter speed

When the zoom is set fully to the W side, you can select an aperture, F2.8 or F5.6.
When the zoom is set fully to the T side, you can select an aperture, F5.2 or F10.
You can select a shutter speed from 1/1000 to 30 seconds.
The difference between the settings and proper exposure judged by the camera appears as an EV value on the screen. 0EV indicates the value judged as the most suitable by the camera.

③ Shoot the image.

- To use the close-up (Macro), or self-timer function, or to change the flash mode, press ● to cancel the manual exposure setup mode after step ①. (The “Return” indicator changes to “Set”.)
- The flash is set to ☑ (Flash forced on) or ☐ (Flash forced off).
- Shutter speeds of one second or longer are indicated by [“], for example, 1”.
- When you set the shutter speed slower, using a tripod is recommended to prevent the effects of vibration.
• When using certain shutter speeds*, the NR slow shutter function activates automatically to reduce the picture noise and “NR” appears.
• If you select slow shutter speeds, it takes time to process the data.

* When the shutter speed is equal to one second or slower.
Using the menu

Using menu items

1 Recording: Turn on the camera, then set the mode dial.
   Playback: Press \( \text{ } \).

   Different items are available depending on the position of the mode dial and Recording/Playback mode.

2 Press MENU to display the menu.

3 Select the desired menu item with \( \uparrow/\downarrow \)
   on the control button.
   • If the desired item is invisible, keep pressing \( \uparrow/\downarrow \)
     until the item appears on the screen.
   • Press \( \bullet \) after selecting an item in the Playback
     mode.

4 Select the setting with \( \Delta/\nabla \).

   The setting you select is zoomed and is set.

5 Press MENU to turn off the menu.

To change to the recording mode

You can also press the shutter button halfway down to turn off the menu.

• If there is an item that is not displayed, an \( \Delta/\nabla \) mark appears on the edges of the location where menu
  items usually appear. To display an item that is not displayed, select the mark with the control button.
• You cannot set items that are not available to select.
Menu items

Menu for shooting (page 34)

The menu items available vary depending on the mode dial position. Only the available items are displayed on the screen.

Using the menu

Menu items

For details on the operation page 32

Menu for shooting (page 34)

The menu items available vary depending on the mode dial position. Only the available items are displayed on the screen.

Menu for viewing (page 41)

* The operation is limited according to the Scene mode (page 30).

**Available only during playback zoom.
The default settings are marked with ☑.

### COLOR (Color Mode)

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>B&amp;W (B &amp; W)</td>
<td>Sets the image to monochromatic color</td>
</tr>
<tr>
<td>Sepia (SEPIA)</td>
<td>Sets the image to sepia color</td>
</tr>
<tr>
<td>Natural (NATURAL)</td>
<td>Sets the image to quiet color</td>
</tr>
<tr>
<td>Vivid (VIVID)</td>
<td>Sets the image to bright and deep color</td>
</tr>
<tr>
<td>☑ Normal</td>
<td></td>
</tr>
</tbody>
</table>

- You can select only [B&W] and [Sepia] when shooting movies.
- When [Multi Burst] is selected, the color mode is set to [Normal].
You can change the focus method. Use the menu when it is difficult to get the proper focus in auto focus mode.

<table>
<thead>
<tr>
<th>(Focus)</th>
<th>Action</th>
</tr>
</thead>
</table>
| **∞ (unlimited distance)** | Focuses on the subject using a previously set distance to the subject. (Focus preset)  
- When shooting a subject through a net or through window glass, it is difficult to get the proper focus in auto focus mode. In these cases, use of [Focus] is convenient. |
| 7.0m |  |
| 3.0m |  |
| 1.0m |  |
| 0.5m |  |
| Center AF | Focuses automatically on a subject in the center of the finder frame.  
- Using this with the AF lock function lets you shoot in the desired image composition. |
| Multi AF | Focuses automatically on a subject in all ranges of the finder frame.  
- This mode is useful when the subject is not in the center of the frame. |

- AF stands for Auto Focus.
- Distance setting information in “Focus preset” is approximate. If you point the lens up or down, the error increases.
- When you are shooting movies, [Multi AF] is recommended as the AF works even with a certain amount of vibration.
- When you use Digital Zoom or AF Illuminator, priority AF movement is given to subjects in or near the center of the frame. In this case the or indicator flashes and the AF range finder frame is not displayed.
- Some options are not available depending on the Scene mode (page 30).
If the subject is out of focus
When shooting with the subject at the edge of the frame (or the screen), or when using [Center AF], the camera may not focus on a subject at the edge of the frame. In such cases, do as follows.

1. Recompose the shot so that the subject is centered in the AF range finder, and press the shutter button halfway down to focus on the subject (AF lock).

As long as you do not press the shutter button fully down, you can retry the procedure as many times as you want.

2. When the AE/AF lock indicator stops flashing and remains on, return to the fully composed shot, and press the shutter button fully down.

(Metering Mode)
Selects the metering mode that sets which part of the subject to measure to determine the exposure.

<table>
<thead>
<tr>
<th>Metering Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Spot (Spot metering) [Spot]</td>
<td>Measures only a part of the subject.</td>
</tr>
<tr>
<td></td>
<td>• This function is useful when the subject is backlit or when there is</td>
</tr>
<tr>
<td></td>
<td>strong contrast between the subject and the background.</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Spot metering cross hairs" /></td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Positions on the subject" /></td>
</tr>
<tr>
<td>Center (Center-weighted</td>
<td>Measures the center of the image, and determines the exposure based on the</td>
</tr>
<tr>
<td>metering) [Center]</td>
<td>brightness of the subject there.</td>
</tr>
<tr>
<td>Multi (Multi-pattern</td>
<td>Divides into multiple regions and measures each region. The camera</td>
</tr>
<tr>
<td>metering) [Multi]</td>
<td>determines a well-balanced exposure.</td>
</tr>
</tbody>
</table>

For details on the operation ➝ page 32

For details on the operation ➝ page 32

For details on the operation ➝ page 32

For details on the exposure ➝ page 14

* When using spot metering or center-weighted metering, setting [Focus] (Focus) to [Center AF] is recommended to focus on the metering position (page 35).
For details on the operation page 32

**WB (White Bal)**

Adjusts the color tones according to the lighting condition in a situation, for example, when the colors of an image look strange.

| Flash (WB)       | Adjusts for the flash conditions.  
|------------------|-----------------------------------
|                  | • You cannot select this item when shooting movies.  

| Incandescent (💡) | Adjusts for places where the lighting conditions change quickly such as at a party hall, or under bright lighting such as at photography studios.  
|-------------------|-------------------------------------------------

| Fluorescent (蛍)  | Adjusts for fluorescent lighting.  
|-------------------|----------------------------------

| Cloudy (曇)       | Adjusts for a cloudy sky.  
|-------------------|-------------------------

| Daylight (☀)      | Adjusts for outdoors, shooting night scenes, neon signs, fireworks, or sunrise, or conditions before and after sundown.  
|-------------------|----------------------------------

| ✔ Auto            | Adjusts the White Balance automatically.  
|-------------------|----------------------------------

- For details on the white balance → page 16
- Under fluorescent lights that flicker, the white balance function may not work correctly even though you select [Fluorescent] (蛍).
- Except in [Flash] (WB) modes, [WB] is set to [Auto] when the flash strobes.
- Some options are not available depending on the Scene mode (page 30).

**ISO**

Selects a luminous sensitivity with units of ISO. The larger the number, the higher the sensitivity.

| 1250            | Select a large number when shooting in dark locations or shooting a subject moving at high speed, or select a small number to obtain high image quality.  
|-----------------|----------------------------------------------------------------------------------
| 800             | 400  
| 200             | 100  
| 80              | ✔ Auto  

- For details on the ISO sensitivity → page 15
- Note that the image tends to become noisier as the ISO sensitivity number increases.
- [ISO] is set to [Auto] in the Scene mode.
- When shooting under brighter conditions, the camera automatically increases its tone reproduction and helps prevent images to become whitish (excluding when [ISO] is set to [80] or [100]).
Selects the still image quality.

<table>
<thead>
<tr>
<th>✔️ Fine (FINE)</th>
<th>Records with high quality (low compression).</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔️ Standard (STD)</td>
<td>Records with standard quality (high compression).</td>
</tr>
</tbody>
</table>

* For details on the image quality → page 16

Selects whether the camera performs continuous shooting or not when you press the shutter button.

<table>
<thead>
<tr>
<th>Multi Burst ( )</th>
<th>Records 16 frames in succession as a still image file when you press the shutter button.</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔️ Normal</td>
<td>Does not shoot continuously.</td>
</tr>
</tbody>
</table>

On the [Multi Burst]

- You can successively play back images shot in the Multi Burst mode using the following procedures:
  - To pause/resume: Press ● on the control button.
  - To play back frame-by-frame: Press ◀/▶ in pause mode. Press ● to resume playback in series.
- You cannot use the following functions in the Multi Burst mode:
  - Smart zoom
  - Flash
  - Dividing a series of images shot in the Multi Burst mode
  - Deleting or extracting a frame in a series of images shot in the Multi Burst mode
  - Setting the frame interval to a mode other than [1/30] when the mode dial is set to
  - Setting the shutter speed to lower than 1/30 second when the mode dial is set to M
- When playing back a series of images shot in the Multi Burst mode using a computer or a camera not equipped with the Multi Burst function, the image is displayed as a single image with 16 frames.
- The image size of images shot in the Multi Burst mode is 1M.
- You may not be able to shoot images in the Multi Burst mode depending on the Scene mode (page 30).
On the [Burst]

- The flash is set to (Flash forced off).
- When recording with the self timer, a series of a maximum of five images is recorded.
- When the mode dial is set to M, the shutter speed cannot be set to one second or slower.
- When the battery level is low, or when the internal memory or “Memory Stick Duo” is full, the Burst stops.
- You may not be able to shoot images in the Burst mode depending on the Scene mode (page 30).
- The recording interval is approximately 1.0 seconds.

The maximum number of continuous shots

(Units: images)

<table>
<thead>
<tr>
<th>Size</th>
<th>Quality</th>
<th>Fine</th>
<th>Standard</th>
</tr>
</thead>
<tbody>
<tr>
<td>8M</td>
<td>Fine</td>
<td>4</td>
<td>6</td>
</tr>
<tr>
<td>3:2</td>
<td>Fine</td>
<td>4</td>
<td>6</td>
</tr>
<tr>
<td>5M</td>
<td>Fine</td>
<td>5</td>
<td>9</td>
</tr>
<tr>
<td>3M</td>
<td>Fine</td>
<td>8</td>
<td>14</td>
</tr>
<tr>
<td>2M</td>
<td>Fine</td>
<td>13</td>
<td>23</td>
</tr>
<tr>
<td>VGA</td>
<td>Fine</td>
<td>73</td>
<td>100</td>
</tr>
<tr>
<td>16:9</td>
<td>Fine</td>
<td>13</td>
<td>23</td>
</tr>
</tbody>
</table>
Selects the frame interval in the [Multi Burst] mode (page 38).

<table>
<thead>
<tr>
<th>Interval</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1/7.5</td>
<td>Select [Multi Burst] with [Mode] first, set the desired setting for [Interval]. When you select a function other than [Multi Burst], this function is unavailable.</td>
</tr>
<tr>
<td>1/15</td>
<td></td>
</tr>
<tr>
<td>1/30</td>
<td></td>
</tr>
</tbody>
</table>

Adjusts the amount of flash light.

<table>
<thead>
<tr>
<th>Level</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>+</td>
<td>Toward +: Makes the flash level higher.</td>
</tr>
<tr>
<td>Normal</td>
<td>Toward −: Makes the flash level lower.</td>
</tr>
</tbody>
</table>

* To change flash mode → step 5 in “Read This First”

Adjusts the contrast of the image.

<table>
<thead>
<tr>
<th>Contrast</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>+</td>
<td>Toward +: Enhances the contrast.</td>
</tr>
<tr>
<td>Normal</td>
<td>Toward −: Reduces the contrast.</td>
</tr>
</tbody>
</table>

Adjusts the sharpness of the image.

<table>
<thead>
<tr>
<th>Sharpness</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>+</td>
<td>Toward +: Sharpens the image.</td>
</tr>
<tr>
<td>Normal</td>
<td>Toward −: Softens the image.</td>
</tr>
</tbody>
</table>

See page 48.
Viewing menu

For details on the operation page 32

The default settings are marked with ✔.

📁 (Folder)

Selects the folder containing the image you want to play back when using the camera with “Memory Stick Duo”.

<table>
<thead>
<tr>
<th>OK</th>
<th>See the following procedure.</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔ Cancel</td>
<td>Cancels the selection.</td>
</tr>
</tbody>
</table>

① Select the desired folder with ⇧/⇨ on the control button.

② Select [OK] with ▲, then press ●.

🔍 On the folder

The camera stores images in a specified folder of a “Memory Stick Duo” (page 53). You can change the folder or create a new one.

• To create a new folder ➔ [Create REC. Folder] (page 53)
• To change the folder for recording images ➔ [Change REC. Folder] (page 54)
• When multiple folders are created in the “Memory Stick Duo” and the first or last image in the folder is displayed, the following indicators appear.
  - Move to the previous folder.
  - Move to the next folder.
  - Move to either the previous and next folders.
Protects images against accidental erasure.

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Protect (Protect)</td>
<td>See the following procedure.</td>
</tr>
<tr>
<td>Exit</td>
<td>Exits the Protection function.</td>
</tr>
</tbody>
</table>

**To protect images in single-image mode**

1. Display the image you want to protect.
2. Press MENU to display the menu.
3. Select [Protect] (Protect) with ◀/▶ on the control button, then press ●. The image is protected and the (protect) indicator appears on the image.
4. To protect other images, select the desired image with ◀/▶, then press ●.

**To protect images in index mode**

1. Slide (Index) lever to display the index screen.
2. Press MENU to display the menu.
3. Select [Protect] (Protect) with ◀/▶ on the control button, then press ●.
4. Select [Select] with ▲/▼, then press ●.
5. Select the image you want to protect with ▲/▼/◀/▶, then press ●. A green (green) indicator appears on the selected image.
6. Repeat step 5 to protect other images.
7. Press MENU.
8. Select [OK] with ◀, then press ●. The (protect) indicator turns white. The selected images are protected.
9. To protect all images in the folder, select [All In This Folder] in step 4, and press ●. Select [On] with ◀, then press ●.
To cancel the protection

In single-image mode
Press ● in step ③ or ④ of “To protect images in single-image mode.”

In index mode
① Select the image for which you want to remove protection in step ⑤ of “To protect images in index mode.”
② Press ● to turn the индикатор gray.
③ Press MENU, select [OK] with ▶, and then press ●.
④ Repeat the operation above for all images to be unprotected.

To cancel protection of all images in the folder
Select [All In This Folder] in step ④ of “To protect images in index mode,” and press ●. Select [Off] with ▶, then press ●.

- Note that formatting the internal memory or “Memory Stick Duo” erases all the data stored on the recording media, even if images are protected, and these images cannot be recovered.
- It may take some time to protect an image.

DPOF

Adds a ✖️ (Print order) mark to images you want to print (page 78).

(Print)

See page 75.

(Slide)

Plays back recorded images in order (Slide show).

Interval

<table>
<thead>
<tr>
<th>✔️ 3 sec</th>
<th>Sets the slide show interval.</th>
</tr>
</thead>
<tbody>
<tr>
<td>5 sec</td>
<td></td>
</tr>
<tr>
<td>10 sec</td>
<td></td>
</tr>
<tr>
<td>30 sec</td>
<td></td>
</tr>
<tr>
<td>1 min</td>
<td></td>
</tr>
</tbody>
</table>
Repeat

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>On</td>
<td>Plays back images in a continuous loop.</td>
</tr>
<tr>
<td>Off</td>
<td>After all the images have been played back, the slide show ends.</td>
</tr>
</tbody>
</table>

Image

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Folder</td>
<td>Plays back all images in the selected folder.</td>
</tr>
<tr>
<td>All</td>
<td>Plays back all images stored on the “Memory Stick Duo”.</td>
</tr>
<tr>
<td>Start</td>
<td>See the following procedure.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Cancels the slide show.</td>
</tr>
</tbody>
</table>

1. Select [Interval], [Repeat] and [Image] with ▲/▼/◄/► on the control button.
2. Select [Start] with ▼/►, then press ●. The slide show starts.

To end the slide show, press ● to pause the slide show. Select [Exit] with ▼, then press ●.

- When pausing during the slide show, you can display the previous/next image with ◄/►.
- The interval time is just a guideline, so it may vary depending on the image size, etc.

(Resize)

You can change the image size of a recorded image (Resize), and save it as a new file. The original image is retained even after resizing.

<table>
<thead>
<tr>
<th>Size</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>8M</td>
<td>The setting size is just a guideline.</td>
</tr>
<tr>
<td></td>
<td>step 4 in “Read This First”</td>
</tr>
<tr>
<td>5M</td>
<td></td>
</tr>
<tr>
<td>3M</td>
<td></td>
</tr>
<tr>
<td>2M</td>
<td></td>
</tr>
<tr>
<td>VGA</td>
<td></td>
</tr>
<tr>
<td>Cancel</td>
<td>Cancels resizing.</td>
</tr>
</tbody>
</table>

1. Display the image you want to resize.
2. Press MENU to display the menu.
3. Select [ ] (Resize) with ◄/► on the control button, then press ●.
4. Select the desired size with ▲/▼, then press ●.

The resized image is recorded in the recording folder as the newest file.
For details on [Image Size] → step 4 in “Read This First”

- You cannot change the size of movies or Multi Burst images.
- When you change from a small size to a large size, the image quality deteriorates.
- You cannot resize the image size to [3:2] or [16:9].
- When you resize a [3:2] or [16:9] image, the upper and lower black portions will be displayed on the image.

### (Rotate)

Rotates a still image.

<table>
<thead>
<tr>
<th></th>
<th>Rotates an image. See the following procedure.</th>
</tr>
</thead>
<tbody>
<tr>
<td>OK</td>
<td>Determines the rotation. See the following procedure.</td>
</tr>
<tr>
<td>✓ Cancel</td>
<td>Cancels rotation.</td>
</tr>
</tbody>
</table>

1. Display the image to be rotated.
2. Press MENU to display the menu.
3. Select [ \\ ] (Rotate) with ◄/► on the control button, then press ●.
4. Select [ \\ ] with △, then rotate the image with ◄/►.
5. Select [OK] with ▲/▼, then press ●.

- You cannot rotate protected images, movies, or Multi Burst images.
- You may not be able to rotate images shot with other cameras.
- When viewing images on a computer, the image rotation information may not be reflected depending on the software.

### (Divide)

Cuts movies, or deletes unnecessary portions of movies. This is the recommended function to use when the internal memory or “Memory Stick Duo” capacity is insufficient, or when you attach movies to your e-mail messages.

- Note that the original movie is deleted and that number is skipped. Also note that you cannot restore files once you cut them.

<table>
<thead>
<tr>
<th></th>
<th>See the following procedure.</th>
</tr>
</thead>
<tbody>
<tr>
<td>✓ Cancel</td>
<td>Cancels division.</td>
</tr>
</tbody>
</table>
Example: Cutting a movie numbered 101_0002

This section describes an example of dividing a movie numbered 101_0002 and deleting it in the following file configuration.

1 Cutting scene A.

2 Cutting scene B.

3 Deleting scenes A and B if they are unnecessary.

4 Only the desired scenes remain.

Procedure

① Display the movie to be divided.
② Press MENU to display the menu.
③ Select [ ] (Divide) with ◀/▶ on the control button, then press ●. Select [OK] with ▲, then press ●.
④ The playback of the movie starts.
5 Press ● at the desired cutting point.

- When you want to adjust the cutting point, select [ ◄/►] (frame rewind/forward) and adjust the cutting point using ◄/►.
- If you want to change the cutting point, select [Cancel]. The playback of the movie starts again.

6 Select [OK] with ▲/▼, and press ●.

7 Select [OK] with ▲, then press ●.

The movie is cut.

- The cut movies are assigned new numbers, and then recorded as the newest files in the selected recording folder.
- You cannot cut the following kinds of images.
  - Still image
  - Movies not long enough to cut (shorter than about two seconds)
  - Protected movies (page 42)

(Setup)

See page 48.

Trimming

Records an enlarged image (→ step 6 in “Read This First”) as a new file.

<table>
<thead>
<tr>
<th>Trimming</th>
<th>See the following procedure.</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔ Return</td>
<td>Cancels trimming.</td>
</tr>
</tbody>
</table>

1 Press MENU during playback zoom to display the menu.

2 Select [Trimming] with ▲ on the control button, then press ●.

3 Select the image size with ▲/▼, then press ●.

The image is recorded, and the original image is displayed again.

- The trimmed image is recorded as the newest file in the selected recording folder, and the original image is retained.
- The quality of trimmed images may deteriorate.
- You cannot trim to an image size of [3:2] or [16:9].
Using the Setup screen

You can change the default settings using the Setup screen.

1 Turn on the camera.

2 Press MENU to display the menu.

3 After pressing ► on the control button, go to the  (Setup) setting, then press ► again.

4 Press ▲/▼/◄/► on the control button to select the item you want to set.
   The frame of the selected item turns yellow.

5 Press ● to enter the setting.

To turn off the  (Setup) screen, press MENU.  
To return to the menu from the  (Setup) screen, press ◄ on the control button repeatedly.  
- Press the shutter button halfway down to turn off the  (Setup) screen and return to the shooting mode.  

When the menu is not displayed  
If you press MENU longer, the  (Setup) is displayed.  

To cancel the  (Setup) setting  
Select [Cancel] if it appears, then press ● on the control button.  If it does not appear, select the previous setting again.  
- This setting is maintained even when the power is turned off.
The default settings are marked with √.

**AF Mode**

Selects the auto focus operation mode.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>✔</td>
<td>Single (S AF)</td>
</tr>
</tbody>
</table>
|   | Monitor (M AF) | Automatically adjusts the focus before the shutter button is pressed and held halfway down. This mode shortens the time needed for focusing.  
  • Battery consumption is faster than in [Single] mode. |

**Digital Zoom**

Selects the digital zoom mode. The camera enlarges the image using optical zoom (up to 3×). When the zoom scale exceeds 3×, the camera uses either smart or precision digital zoom.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
</table>
| ✔  | Smart  
  (Smart zoom)  
  (Smart zoom) | Enlarges the image digitally with almost no distortion. This is not available when the image size is set to [8M] or [3:2].  
  • The maximum zoom scale of Smart zoom is shown in the following table. |
|   | Precision  
  (Precision digital zoom)  
  (Precision digital zoom) | Enlarges all image sizes up to a maximum of 6×, but the image quality deteriorates. |
|   | Off | Does not use the digital zoom. |

**Image size and maximum zoom scale using Smart zoom**

<table>
<thead>
<tr>
<th>Size</th>
<th>Maximum zoom scale</th>
</tr>
</thead>
<tbody>
<tr>
<td>5M</td>
<td>Approx. 3.8×</td>
</tr>
<tr>
<td>3M</td>
<td>Approx. 4.8×</td>
</tr>
<tr>
<td>2M</td>
<td>Approx. 6×</td>
</tr>
<tr>
<td>VGA</td>
<td>Approx. 15×</td>
</tr>
<tr>
<td>16:9</td>
<td>Approx. 5.1×</td>
</tr>
</tbody>
</table>
• If you slide the zoom lever, the zoom scale is displayed.

![Zoom Lever Diagram]

The W side of this line is the optical zoom area, and the T side is the digital zoom area.

• The maximum zoom scale of smart zoom/precision zoom includes the scale of the optical zoom.
• The AF range finder frame does not appear when using the digital zoom. The ■ or ● indicator flashes, and AF operates with priority on subjects located near the center of the frame.
• When using the smart zoom, the image on the screen may look rough. However, this phenomenon has no effect on the recorded image.

## Function Guide

When you operate the camera, the instructions of various functions are displayed.

<table>
<thead>
<tr>
<th>Function Guide</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>On</strong></td>
<td>Displays the function guide.</td>
</tr>
<tr>
<td><strong>Off</strong></td>
<td>Does not display the function guide.</td>
</tr>
</tbody>
</table>

## Red Eye Reduction

Reduces the red-eye phenomenon when using the flash. Select this before shooting.

<table>
<thead>
<tr>
<th>Red Eye Reduction</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>On ( )</strong></td>
<td>Reduces the red-eye phenomenon.</td>
</tr>
<tr>
<td></td>
<td>• The flash pre-strobes twice or more before shooting.</td>
</tr>
<tr>
<td><strong>Off</strong></td>
<td>Does not use Red Eye Reduction.</td>
</tr>
</tbody>
</table>

• Because it takes about a second until the shutter clicks, hold the camera firmly to prevent the effects of vibration. Also, do not let the subject move.
• Red-eye reduction may not produce the desired effects depending on individual differences, the distance to the subject, if the subject does not see the pre-strobe, or other conditions.
AF Illuminator

The AF illuminator supplies fill light to focus more easily on a subject in dark surroundings. The AF illuminator emits red light allowing the camera to focus easily when the shutter button is pressed halfway, until the focus is locked. The \( \text{ON} \) indicator appears at this time.

<table>
<thead>
<tr>
<th>✔️</th>
<th>Auto</th>
<th>Uses the AF illuminator.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td></td>
<td>Does not use AF illuminator.</td>
</tr>
</tbody>
</table>

- If the AF illuminator light does not reach the subject sufficiently or the subject has no contrast, focus will not be achieved. (A distance of up to approximately 3.2 m (10 feet 6 3/8 inches) (zoom: W) / 2.4 m (7 feet 10 3/4 inches) (zoom: T) is recommended.)
- Focus is achieved as long as the AF illuminator light reaches the subject, even if the light is slightly off the center of the subject.
- When Focus preset is set (page 35), AF Illuminator does not function.
- The AF range finder frame does not appear. The \( \text{ON} \) or \( \text{OFF} \) indicator flashes, and AF operates with priority on subjects located near the center of the frame.
- The AF illuminator does not operate when \( \text{ON} \) (Twilight mode) or \( \text{OFF} \) (Landscape mode) is selected in the Scene mode.
- The AF illuminator emits very bright light. Although there are no problems with safety, do not look directly into the AF illuminator emitter at close range.

Auto Review

Displays the recorded image on the screen for approximately two seconds immediately after shooting a still image.

<table>
<thead>
<tr>
<th>✔️</th>
<th>On</th>
<th>Use the Auto Review.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td></td>
<td>Does not use Auto Review.</td>
</tr>
</tbody>
</table>

- If you press the shutter button halfway down during this period, the recorded image display disappears and you can immediately shoot the next image.
For details on the operation page 48

Internal Memory Tool

This item does not appear when a “Memory Stick Duo” is inserted in the camera. The default settings are marked with ✓.

Format

Formats the internal memory.

- Note that formatting irrevocably erases all data in the internal memory, including even protected images.

<table>
<thead>
<tr>
<th>OK</th>
<th>See the following procedure.</th>
</tr>
</thead>
<tbody>
<tr>
<td>✓ Cancel</td>
<td>Cancels the formatting.</td>
</tr>
</tbody>
</table>

① Select [OK] with ▲ on the control button, then press ●. The message “All data in internal memory will be erased Ready?” appears.

② Select [OK] with ▲, then press ●. The format is complete.
This item appears only when a “Memory Stick Duo” is inserted in the camera. The default settings are marked with ✓.

**Format**

Formats the “Memory Stick Duo”. A commercially available “Memory Stick Duo” is already formatted, and can be used immediately.

- Note that formatting irrevocably erases all data on a “Memory Stick Duo”, including even protected images.

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>OK</td>
<td>See the following procedure.</td>
</tr>
<tr>
<td>✓ Cancel</td>
<td>Cancels the formatting.</td>
</tr>
</tbody>
</table>

1. Select [OK] with ▲ on the control button, then press ●.
   The message “All data in Memory Stick will be erased Ready?” appears.
2. Select [OK] with ▲, then press ●.
   The format is complete.

**Create REC. Folder**

Creates a folder in a “Memory Stick Duo” for recording images.

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>OK</td>
<td>See the following procedure.</td>
</tr>
<tr>
<td>✓ Cancel</td>
<td>Cancels folder creation.</td>
</tr>
</tbody>
</table>

1. Select [OK] with ▲ on the control button, then press ●.
   The folder creation screen appears.
2. Select [OK] with ▲, then press ●.
   A new folder is created with a number incremented one higher than the largest number, and the folder becomes the current recording folder.

- For details on the folder, see page 41.
- When not creating a new folder, the “101MSDCF” folder is selected as the recording folder.
- You can create folders designated up to “999MSDCF”
- Images are recorded in the newly created folder until a different folder is created or selected.
- You cannot delete a folder with the camera. To delete a folder, use your computer, etc.
- Up to 4,000 images can be stored in one folder. When the folder capacity is exceeded, a new folder is automatically created.
- For details, see “Image file storage destinations and file names” (page 66).
**Change REC. Folder**

Changes the folder currently used for recording images.

<table>
<thead>
<tr>
<th>OK</th>
<th>See the following procedure.</th>
</tr>
</thead>
<tbody>
<tr>
<td>✅ Cancel</td>
<td>Cancels changing the recording folder.</td>
</tr>
</tbody>
</table>

1. Select [OK] with ▲ on the control button, then press ●.
   The folder selection screen appears.

2. Select the desired folder with ◀/▶, and [OK] with ▲, then press ●.
   - You cannot select the “100MSDCF” folder as a recording folder.
   - You cannot move recorded images to a different folder.

**Copy**

Copies all images in the internal memory to a “Memory Stick Duo”.

<table>
<thead>
<tr>
<th>OK</th>
<th>See the following procedure.</th>
</tr>
</thead>
<tbody>
<tr>
<td>✅ Cancel</td>
<td>Cancels the copying.</td>
</tr>
</tbody>
</table>

1. Insert a “Memory Stick Duo” having 64 MB or larger capacity.
2. Select [OK] with ▲ on the control button, then press ●.
   The message “All data in internal memory will be copied Ready?” appears.
3. Select [OK] with ▲, then press ●.
   Copying starts.

- Use a fully charged battery pack or the AC Adaptor (not supplied). If you attempt to copy image files using a battery pack with little remaining charge, the battery pack may run out, causing copying to fail or possibly corrupting the data.
- You cannot copy individual images.
- The original images in the internal memory are retained even after copying. To delete the contents of the internal memory, remove the “Memory Stick Duo” after copying, then execute the [Format] command in (Internal Memory Tool) (page 52).
- You cannot select a folder copied on a “Memory Stick Duo”.
- Even if you copy data, a (Print order) mark is not copied.
The default settings are marked with ✔.

**LCD Backlight**

Selects the brightness of the LCD backlight when using the camera with battery pack.

<table>
<thead>
<tr>
<th>Bright</th>
<th>Brightens.</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔ Normal</td>
<td></td>
</tr>
</tbody>
</table>

- You can also change the setting with [ ] (Screen display switch) button pressed longer (→ *step 5 in “Read This First”).
- Selecting [Bright] uses up the battery pack charge faster.

**Beep**

Selects the sound produced when you operate the camera.

<table>
<thead>
<tr>
<th>Shutter</th>
<th>Turns on the shutter sound when you press the shutter button.</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔ On</td>
<td>Turns on the beep/shutter sound when you press the control button/ press the shutter button.</td>
</tr>
<tr>
<td>Off</td>
<td>Turns off the beep/shutter sound.</td>
</tr>
</tbody>
</table>

**Language**

Selects the language to be used to display the menu items, warnings, and messages.

**Initialize**

Initializes the setting to the default setting.

<table>
<thead>
<tr>
<th>OK</th>
<th>See the following procedure.</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔ Cancel</td>
<td>Cancels the resetting.</td>
</tr>
</tbody>
</table>

1. Select [OK] with ▲ on the control button, then press ●.
   The message “Initialize all settings Ready?” appears.
2. Select [OK] with ▲, then press ●.
   The settings are reset to the default setting.
- Make sure that the power is not disconnected during resetting.
The default settings are marked with ✔.

### File Number

Selects the method used to assign file numbers to images.

<table>
<thead>
<tr>
<th>File Number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔ Series</td>
<td>Assigns numbers to files in sequence even if the recording folder or the “Memory Stick Duo” is changed. (When the replaced “Memory Stick Duo” contains a file with a number higher than the last assigned number, a number one higher than the largest number is assigned.)</td>
</tr>
<tr>
<td>Reset</td>
<td>Starts from 0001 each time the folder is changed. (When the recording folder contains a file, a number one higher than the largest number is assigned.)</td>
</tr>
</tbody>
</table>

### USB Connect

Selects the USB mode to be used when connecting the camera to a computer or a PictBridge compliant printer using the cable for multi-use terminal.

<table>
<thead>
<tr>
<th>USB Connect</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PictBridge</td>
<td>Connects the camera to a PictBridge compliant printer (page 75).</td>
</tr>
<tr>
<td>PTP</td>
<td>When [PTP] (Picture Transfer Protocol) is set and the camera is connected to a computer, the images in the recording folder on the camera are copied to the computer. (Compatible with Windows XP and Mac OS X.)</td>
</tr>
<tr>
<td>Mass Storage</td>
<td>Establishes a Mass Storage connection between the camera and a computer or other USB device (page 62).</td>
</tr>
<tr>
<td>✔ Auto</td>
<td>The camera recognizes automatically and sets up communication with a computer or PictBridge compliant printer (pages 62 and 75).</td>
</tr>
<tr>
<td></td>
<td>• If the camera and a PictBridge compliant printer cannot be connected when set to [Auto], change the setting to [PictBridge].</td>
</tr>
<tr>
<td></td>
<td>• If the camera and a computer or other USB device cannot be connected when set to [Auto], change the setting to [Mass Storage].</td>
</tr>
</tbody>
</table>
Using the Setup screen

For details on the operation page 48

### Video Out

Sets the video signal output according to the TV color system of the connected video equipment. Different countries and regions use different TV color systems. If you want to view images on a TV screen, check page 81 for the TV color system of the country or region where the camera is used.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>NTSC</td>
<td>Sets the video output signal to NTSC mode (e.g., for the USA, Japan).</td>
</tr>
<tr>
<td>PAL</td>
<td>Sets the video output signal to PAL mode (e.g., for Europe).</td>
</tr>
</tbody>
</table>

### Clock Set

Sets the date and time.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>OK</td>
<td>Select [OK] with ▲ on the control button, and press ●. Then, perform the procedure explained in “Set the clock” (→ step 2 in “Read This First”).</td>
</tr>
<tr>
<td>✔️</td>
<td>Cancel</td>
</tr>
</tbody>
</table>
For details on using a Macintosh computer, refer to “Using your Macintosh computer” (page 72). This section describes the English version screen contents.

1. Install the software (supplied) first (page 60)

2. Copying images to your computer (page 61)

   Viewing images on your computer

3. Enjoying images using the “Cyber-shot Viewer” (page 68)
   - Viewing images saved on your computer
   - Viewing photos organized by date
   - Editing images

4. Printing images
Using your computer

The following environment is recommended for a computer connected to the camera.

Recommended environment for copying images


- Operation is not assured in an environment based on an upgrade of the operating systems described above or in a multi-boot environment.

**USB jack:** Provided as standard

Recommended environment for using “Cyber-shot Viewer”


**Sound card:** 16-bit stereo sound card with speakers

**Processor/Memory:** Pentium III 500 MHz or faster, 128 MB of RAM or more
(Recommended: Pentium III 800 MHz or faster and 256 MB of RAM or more)

**Hard Disk:** Disk space required for installation—200 MB or more

**Display:**
- Screen resolution: 800 x 600 dots or more
- Colors: High Color (16-bit color, 65,000 colors) or more

Notes on connecting your camera to a computer

- Operations are not guaranteed for all the recommended computer environments mentioned above.
- If you connect two or more USB devices to a single computer at the same time, some devices, including your camera, may not operate, depending on the types of USB devices you are using.
- Operations are not guaranteed when using a USB hub.
- Connecting your camera using a USB interface that is compatible with Hi-Speed USB (USB 2.0 compliant) allows advanced transfer (high speed transfer) as this camera is compatible with Hi-Speed USB (USB 2.0 compliant).
- There are three modes for a USB connection when connecting a computer, [Auto] (default setting), [Mass Storage] and [PTP] modes. This section describes the [Auto] and [Mass Storage] as examples. For details on [PTP], see page 56.
- When your computer resumes from a suspend or sleep mode, communication between your camera and your computer may not recover at the same time.
Installing the software (supplied)

You can install the software (supplied) using the following procedure.

- When using Windows 2000/Me, do not connect the camera to the computer before installation.
- In Windows 2000/XP, log on as Administrator.
- When the supplied software is installed, the USB driver is installed automatically.

1 Turn on your computer, and insert the CD-ROM (supplied) into the CD-ROM drive.

   The installation menu screen appears.

   • If it does not appear, double-click (My Computer) → (CYBERSHOTSOFT).

2 Click [Install].

   The “Choose Setup Language” screen appears.

3 Select the desired language, then click [Next].

   The “License Agreement” screen appears.
   Read the agreement carefully. If you accept the terms of the agreement, click the radio button next to [I accept the terms of the license agreement] and then click [Next].

4 Follow the instructions on the screen to complete the installation.

   When the restarting confirmation message appears, restart the computer following the instructions on the screen.

5 Remove the CD-ROM after the installation is complete.
Using your computer

Copy images to your computer

This section describes the process using a Windows computer as an example. You can copy images from the camera to your computer as follows.

For a computer with a “Memory Stick” slot
Remove the “Memory Stick Duo” from the camera and insert it in the Memory Stick Duo Adaptor. Insert the Memory Stick Duo Adaptor in the computer and copy the images. If the “Memory Stick PRO Duo” is not recognized, see page 90.

For a computer without a “Memory Stick” slot
Follow Stages 1 through 4 on pages 61 to 65 to copy images.
- When using Windows 2000/Me, install the supplied software before proceeding. With Windows XP, the installation is unnecessary.
- The screen displays shown in this section are the examples for copying images from “Memory Stick Duo”.

Stage 1: Preparing the camera and the computer

1 Insert a “Memory Stick Duo” with recorded images into the camera.
   - When copying images in the internal memory, this step is unnecessary.

2 Insert the sufficiently charged battery pack in the camera, or connect the camera to a wall outlet (wall socket) with the AC Adaptor (not supplied).

   • When you copy images to your computer using a battery pack with little remaining charge, copying may fail or image data may become corrupted if the battery pack shuts down too soon.

3 Press  to turn on the camera and the computer.

   • When using Windows 2000/Me, install the supplied software before proceeding. With Windows XP, the installation is unnecessary.
Stage 2: Connecting the camera and your computer

With Windows XP, the AutoPlay wizard appears on the desktop.

“USB Mode Mass Storage” appears on the screen of the camera.

When a USB connection is established for the first time, your computer automatically runs a program to recognize the camera. Wait for a while.

* During communication, the access indicators turn red. Do not operate the computer until the indicators turn white.


Stage 3-A: Copying images to a computer

For Windows 2000/Me, follow the procedure explained in “Stage 3-B: Copying images to a Computer” on page 63.

For Windows XP, when the wizard screen does not appear automatically, follow the procedure explained in “Stage 3-B: Copying images to a Computer” on page 63.

This section describes an example of copying images to a “My Documents” folder.

1. After making a USB connection in Stage 2, click [Copy pictures to a folder on my computer using Microsoft Scanner and Camera Wizard] → [OK] as the wizard screen appears automatically on the desktop.

   The “Scanner and Camera Wizard” screen appears.

2. Click [Next].

   The images saved on the “Memory Stick Duo” of the camera appear.

   * If no “Memory Stick Duo” is inserted, images in the internal memory appear.
3 Click the check box of unwanted images to remove the checkmark so they are not copied, then click [Next].

The “Picture Name and Destination” screen appears.

4 Select a name and destination for the images, then click [Next].

Image copying starts. When the copying is completed, the “Other Options” screen appears.

- This section describes an example of copying images to the “My Documents” folder.

5 Click the radio button next to [Nothing. I'm finished working with these pictures] to select it, then click [Next].

The “Completing the Scanner and Camera Wizard” screen appears.

6 Click [Finish].

The wizard screen closes.

- To continue copying other images, disconnect the cable for multi-use terminal (page 65). Then follow the procedure explained in “Stage 2: Connecting the camera and your computer” on page 62.

Stage 3-B: Copying images to a Computer

- For Windows XP, follow the procedure explained in “Stage 3-A: Copying images to a computer” on page 62.

This section describes an example of copying images to the “My Documents” folder.
1 Double-click [My Computer] → [Removable Disk] → [DCIM].

![Image of My Computer window with DCIM folder highlighted]

- If the “Removable Disk” icon is not displayed, see page 88.

2 Double-click the folder where the image files you want to copy are stored.
   Then, right-click an image file to display the menu and click [Copy].

![Image of My Documents folder with menu options]

- On the storage destination of the image files, see page 66.

3 Double-click the [My Documents] folder. Then, right-click on the “My Documents” window to display the menu and click [Paste].

![Image of My Documents window with menu options]

The image files are copied to the “My Documents” folder.

- When an image with the same file name exists in the copy destination folder, the overwrite confirmation message appears. When you overwrite an existing image with a new one, the original file data is deleted. To copy an image file to the computer without overwriting, change the file name to a different name and then copy the image file. However, note that if you change the file name (page 67), you may not be able to play back that image with your camera.
Stage 4: Viewing images on your computer

This section describes the procedure for viewing copied images in the “My Documents” folder.

1 Click [Start] → [My Documents].

The contents of the “My Documents” folder are displayed.
- If you are not using Windows XP, double-click [My Documents] on the desktop.

2 Double-click the desired image file.

The image is displayed.

To delete the USB connection

Perform the procedures listed below beforehand when:
- Disconnecting the cable for multi-use terminal
- Removing a “Memory Stick Duo”
- Inserting a “Memory Stick Duo” into the camera after copying images from the internal memory
- Turning off the camera

For Windows 2000/Me/XP

① Double-click on the tasktray.

Double-click here

② Click (Sony DSC) → [Stop].
③ Confirm the device on the confirmation window, then click [OK].
④ Click [OK].
The device is disconnected.
- Step 4 is unnecessary for Windows XP.

To delete the USB connection

Perform the procedures listed below beforehand when:
- Disconnecting the cable for multi-use terminal
- Removing a “Memory Stick Duo”
- Inserting a “Memory Stick Duo” into the camera after copying images from the internal memory
- Turning off the camera

For Windows 2000/Me/XP

① Double-click on the tasktray.

Double-click here

② Click (Sony DSC) → [Stop].
③ Confirm the device on the confirmation window, then click [OK].
④ Click [OK].
The device is disconnected.
- Step 4 is unnecessary for Windows XP.
Image file storage destinations and file names

The image files recorded with your camera are grouped as folders on the “Memory Stick Duo”.

Example: viewing folders on Windows XP

A Folder containing image data recorded using a camera not equipped with the folder creating function

B Folder containing image data recorded using this camera
   When no new folders are created, there are folders as follows:
   - “Memory Stick Duo”; “101MSDCF” only
   - Internal memory; “101_SONY” only

- You cannot record any images to the “100MSDCF” folder. The images in these folders are available only for viewing.
- You cannot record/playback any images to the “MISC” folder.
- Image files are named as follows. □□□□ stands for any number within the range from 0001 to 9999. The numerical portions of the name of a movie file recorded in movie mode and its corresponding index image file are the same.
  - Still image files: DSC0□□□□.JPG
  - Movie files: MOV0□□□□.MPG
  - Index image files that are recorded when you record movies: MOV0□□□□.THM

For more information about folders, see pages 41 and 53.
Viewing image files stored on a computer with your camera (using a “Memory Stick Duo”)

This section describes the process using a Windows computer as an example. When an image file copied to a computer no longer remains on a “Memory Stick Duo”, you can view that image again on the camera by copying the image file on the computer to a “Memory Stick Duo”.

- Step 1 is not necessary if the file name set with your camera has not been changed.
- You may be unable to play back some images depending on the image size.
- When an image file has been processed by a computer or when the image file was recorded using a model other than that of your camera, playback on your camera is not guaranteed.
- When there is no folder, first create a folder with your camera (page 53) and then copy the image file.

1 Right-click the image file, then click [Rename]. Change the file name to “DSC0□□□□□.”

Enter a number from 0001 to 9999 for □□□□□.

- If the overwrite confirmation message appears, enter a different number.
- An extension may be displayed depending on the computer settings. The extension for still images is JPG, and the extension for movies is MPG. Do not change the extension.

2 Copy the image file to the “Memory Stick Duo” folder in the following order.

① Right-click the image file, then click [Copy].
② Double-click [Removable Disk] or [Sony MemoryStick] in [My Computer].
③ Right-click the [口口口MSDCF] folder in the [DCIM] folder, then click [Paste].

口口口 stands for any number within the range from 100 to 999.
You can use still images and movies from the camera more than ever by taking advantage of the software. This section summarizes the “Cyber-shot Viewer” and gives basic instructions.

**“Cyber-shot Viewer” overview**

With the “Cyber-shot Viewer” you can:
- Import images shot with the camera and display them on the monitor.
- Organize images on the computer on a calendar by shooting date to view them.
- Retouch, print, and send still images as e-mail attachments, change the shooting date, and more.
- For details on the “Cyber-shot Viewer”, refer to the Help.

To access the Help, click [Start] → [Programs] (in Windows XP, [All Programs]) → [Sony Picture Utility] → [Help] → [Cyber-shot Viewer].

**Starting and exiting the “Cyber-shot Viewer”**

**Starting the “Cyber-shot Viewer”**

Double-click the (Cyber-shot Viewer) icon on the desktop.

Or, from the Start menu: Click [Start] → [Programs] (in Windows XP, [All Programs]) → [Sony Picture Utility] → [Cyber-shot Viewer].

**Exiting the “Cyber-shot Viewer”**

Click button in the top right corner of the screen.

---

**Basic instructions**

Follow these steps to import and view images from the camera.

**Importing images**

1. **Make sure “Media Check Tool”** is running.

* “Media Check Tool” is a program that automatically detects and imports images when a “Memory Stick” is inserted or when the camera is connected.

Look for a (Media Check Tool) icon in the taskbar.

- If there is no icon: Click [Start] → [Programs] (in Windows XP, [All Programs]) → [Sony Picture Utility] → [Cyber-shot Viewer] → [Tools] → [Media Check Tool].

2. **Connect the camera to your computer with the cable for multi-use terminal.**

After the camera is automatically detected, the [Import Images] screen is displayed.

- If you will use the “Memory Stick” slot, first refer to page 61.
- In Windows XP, if the AutoPlay Wizard appears, close it.
3 Import the images.

To start importing images, click the [Import] button.

By default, images are imported into a folder created in “My Pictures” that is named with the date of importing.

• For instructions on changing the “Folder to be imported”, refer to page 71.

Viewing images

1 Checking imported images

When importing is complete, the “Cyber-shot Viewer” starts. Thumbnails of the imported images are displayed.

• The “My Pictures” folder is set as the default folder in “Viewed folders”.
• You can double-click a thumbnail to display the image by itself.

2 Viewing images in “Viewed folders” arranged by shooting date on a calendar

① Click the [Calendar] tab. Years when images were shot are listed.
② Click the year. Images shot that year are displayed, arranged on the calendar by shooting date.
③ To display images by month, click the desired month. Thumbnails of images shot that month are displayed.
④ To display images by time, click the desired date. Thumbnails of images shot that day are displayed, arranged by hour.

Year display screen

Month display screen
Hour display screen

- To list images from a particular year or month, click that period on the left of the screen.

3 Displaying individual images

On the hour display screen, double-click a thumbnail to display the image by itself in a separate window.

- You can edit displayed images by clicking the toolbar button.

Displaying images in full-screen mode

To display a slide show of current images in full-screen mode, click the button.

- To play or pause the slide show, click the button on the lower left of the screen.
- To stop the slide show, click the button on the lower left of the screen.
Preparing images stored on the computer for viewing

To view them, register the folder that contains the images as one of the “Viewed folders”.

From the [File] menu, choose [Register Viewed Folders...] to display the settings screen for “Viewed folders” registration.

Click the [Add...] button, and then specify the folder with images for importing to register the folder as a “Viewed folder.”
- Images in any subfolders of “Viewed folders” are also registered.

Changing the “Folder to be imported”

To change the “Folder to be imported”, access the “Import Settings” screen.

To display the “Import Settings” screen, choose [Image Import Settings...] from the [File] menu.

Choose the “Folder to be imported”.
- You can specify the “Folder to be imported” from folders registered as “Viewed folders.”

Updating image registration information

To update image information, choose [Update Database] from the [Tools] menu.
- Updating the database may take a while.
- If you rename image files or folders in “Viewed folders”, they cannot be displayed with this software. In this case, update the database.

To uninstall the “Cyber-shot Viewer”

1. Click [Start] → [Settings] → [Control Panel], then double-click [Add or Remove Programs]. (For Windows XP: click [Start] → [Control Panel], then double-click [Add or Remove Programs].)
2. Select [Sony Picture Utility], then click [Change/Remove] (For Windows XP: [Remove]) to execute the uninstallation.

Technical Support

Additional information on this product and answers to frequently asked questions can be found at the Sony Customer Support Website. http://www.sony.net/
Using your Macintosh computer

You can copy images to your computer.
• The supplied software is not compatible with Macintosh computers.

Recommended computer environment

The following environment is recommended for a computer connected to the camera.

Recommended environment for copying images

OS (pre-installed): Mac OS 9.1, 9.2 or Mac OS X (v10.0 or later)
USB jack: Provided as standard

Notes on connecting your camera to a computer
• Operations are not guaranteed for all the recommended computer environments mentioned above.
• If you connect two or more USB devices to a single computer at the same time, some devices, including your camera, may not operate depending on the types of USB devices you are using.
• Operations are not guaranteed when using a USB hub.
• Connecting your camera using a USB interface that is compatible with Hi-Speed USB (USB 2.0 compliant) allows advanced transfer (high speed transfer) as this camera is compatible with Hi-Speed USB (USB 2.0 compliant).
• There are three modes for a USB connection when connecting a computer, [Auto] (default setting), [Mass Storage] and [PTP] modes. This section describes the [Auto] and [Mass Storage] as examples. For details on [PTP], see page 56.
• When your computer resumes from the suspend or sleep mode, communication between your camera and your computer may not recover at the same time.

Copying and viewing images on a computer

1 Prepare the camera and a Macintosh computer.

Perform the same procedure as that described in “Stage 1: Preparing the camera and the computer” on page 61.

2 Connect the cable for multi-use terminal.

Perform the same procedure as that described in “Stage 2: Connecting the camera and your computer” on page 62.

3 Copy image files to the Macintosh computer.

① Double-click the newly recognized icon → [DCIM] → the folder where the images you want to copy are stored.
② Drag and drop the image files to the hard disk icon.
The image files are copied to the hard disk.
• For details on the storage location of the images and file names, see page 66.

4 View images on the computer.

Double-click the hard disk icon → the desired image file in the folder containing the copied files to open that image file.
To delete the USB connection

Perform the procedures listed below beforehand when:

• Disconnecting the cable for multi-use terminal
• Removing a “Memory Stick Duo”
• Inserting a “Memory Stick Duo” into the camera after copying images from the internal memory
• Turning off the camera

Drag and drop the drive icon or the icon of the “Memory Stick Duo” to the “Trash” icon.

The camera is disconnected from the computer.

• If you are using Mac OS X v10.0, perform the procedure above after you have turned your computer off.

Technical Support

Additional information on this product and answers to frequently asked questions can be found at the Sony Customer Support Website. http://www.sony.net/
When you print images shot in [16:9] mode, both edges may be cut off, so be sure to check before printing (page 91).

**Printing directly using a PictBridge compliant printer (page 75)**

You can print images by connecting the camera directly to a PictBridge compliant printer.

**Printing directly using a “Memory Stick” compliant printer**

You can print images with a “Memory Stick” compliant printer. For details, see the operating instructions supplied with the printer.

**Printing using a computer**

You can copy images to a computer using the “Cyber-shot Viewer” software in the supplied CD-ROM and print the images.

**Printing at a shop (page 78)**

You can take a “Memory Stick Duo” containing images shot with your camera to a photo printing service shop. You can make a (Print order) mark on images that you want to print out in advance.
Printing images directly using a PictBridge compliant printer

Even if you do not have a computer, you can print images shot using your camera by connecting the camera directly to a PictBridge compliant printer.

**PictBridge**

- “PictBridge” is based on the CIPA standard. (CIPA: Camera & Imaging Products Association)

In single-image mode

You can print a single image on a printing sheet.

In index mode

You can print several images at a reduced size on a printing sheet. You can print a set of either the same images (①) or different images (②).

- An index print function may not be provided depending on the printer.
- The quantity of images that can be printed as an index image differ depending on the printer.
- You cannot print movies.
- If the _indicator flashes on the screen of the camera for about five seconds (error notification), check the connected printer.

**Stage 1: Preparing the camera**

Prepare the camera to connect it to the printer via a USB connection. When connecting the camera to a printer that is recognized when [USB Connect] is set to [Auto], Stage 1 is unnecessary.

1. Press MENU to display the menu.
2. Press ▲ on the control button to select  (Setup).
3. Select [ ] (Setup2) with ▼, then select [USB Connect] with ▲/▼/▲.
4. Select [PictBridge] with ▲/▲, then press ●.

The USB mode is set.
Stage 2: Connecting the camera to the printer

1 Connect the camera to the printer.

2 Turn on your camera and the printer.

After the connection is made, the indicator appears.

The camera is set to playback mode, then an image and the print menu appear on the screen.

Stage 3: Printing

Regardless of what the mode dial is set to, the print menu appears when you complete Stage 2.

1 Select the desired printing method with ▲/▼ on the control button, then press ●.

[All In This Folder] Prints all the images in the folder.

[DPOF image] Prints all the images with a (Print order) mark (page 78) regardless of the displayed image.

[Select] Selects images and prints all the selected images.

① Select the image you want to print with ◀▶, then press ●.
   The mark appears on the selected image.
   • To select other images, repeat this procedure.

② Select [Print] with ▼, then press ●.

[This image] Prints a displayed image.

   • If you select [This image] and set [Index] to [On] in step 2, you can print a set of the same images as an index image.

2 Select print settings with ▲/▼/◀▶.

   [Index]
   [Size]
   [Date]
   [Quantity]

Exit OK
[Index]
Select [On] to print as an index image.

[Size]
Select the size of the printing sheet.

[Date]
Select [Day&Time] or [Date] to insert the date and time on images.
- When you choose [Date], the date will be inserted in the order you select (→ step 2 in “Read This First”). This function may not be provided depending on the printer.

[Quantity]
When [Index] is set to [Off]:
Select the number of sheets of an image that you want to print. The image will be printed as a single image.

When [Index] is set to [On]:
Select the number of sets of images that you want to print as an index image. If you selected [This image] in step 1, select the number of the same image you want to print side by side on a sheet as an index image.
- The designated number of images may not all fit onto a single sheet depending on the quantity of images.

3 Select [OK] with ▼/▲, then press ●.
The image is printed.
- If the icon (PictBridge Connecting) icon appears on the screen, do not disconnect the cable for multi-use terminal.

To print other images
After step 3, select [Select] and the desired image with ▲/▼, then perform from step 1.

To print images on the index screen
Perform “Stage 1: Preparing the camera” (page 75) and “Stage 2: Connecting the camera to the printer” (page 76), then proceed with the following.
When you connect the camera to a printer, the print menu appears. Select [Cancel] to turn off the print menu, then proceed as follows.

① Slide (Index) lever.
The index screen appears.

② Press MENU to display the menu.

③ Select [ ] (Print) with ▲, then press ●.

④ Select the desired printing method with ▲/▼, then press ●.

[Select]
Selects images and prints all the selected images.
Select the image you want to print with ▲/▼/◄/►, then press ● to display the mark. (Repeat this procedure to select other images.) Then, press MENU.

[DPOF image]
Prints all the images with a (Print order) mark regardless of the displayed image.

[All In This Folder]
Prints all the images in the folder.

⑤ Perform steps 2 and 3 of “Stage 3: Printing” (page 76).
Printing at a shop

You can take a “Memory Stick Duo” containing images shot with your camera to a photo printing service shop. As long as the shop supports photo printing services conforming to the DPOF, you can make a (Print order) mark on images in advance so that you do not need to reselect them when you print them out at the shop.

- You cannot print images stored in the internal memory at a print shop directly from the camera. Copy the images to a “Memory Stick Duo”, then take the “Memory Stick Duo” to the print shop.

What is DPOF?

DPOF (Digital Print Order Format) is a function allowing you to make a (Print order) mark on images of “Memory Stick Duo” that you want to print out later.

- You can also print the images with the (Print order) mark using a printer that conforms to the DPOF (Digital Print Order Format) standard or using a PictBridge compliant printer.
- You cannot mark movies.
- When you mark images shot in [Multi Burst] mode, all the images are printed on one sheet divided into 16 panels.

When taking a “Memory Stick Duo” to a shop

- Consult your photo printing service shop as to what types of “Memory Stick Duo” they handle.
- If a “Memory Stick Duo” is not handled by your photo printing service shop, copy the images you want to print out to other medium such as a CD-R and take it to the shop.
- Be sure to take the Memory Stick Duo Adaptor with it.
- Before you take image data to a shop, always copy (back up) your data to a disk.
- You cannot set the number of prints.

Marking in single-image mode

1. Display the image you want to print.

2. Press MENU to display the menu.

3. Select DPOF with ◄/►, then press  .
   A (Print order) mark is marked on the image.

4. To mark other images, display the desired image with ◄/►, then press .

To remove the mark in single-image mode

Press  in step 3 or 4.
Marking in index mode

1 Display the index screen (→ step 6 in “Read This First”).

2 Press MENU to display the menu.

3 Select DPOF with ◄/►, then press ●.

4 Select [Select] with ▲/▼, then press ●.
   - You cannot add a ✁ mark in [All In This Folder].

5 Select the image you want to mark with ▲/▼/◄/►, then press ●.
   A green ✁ mark appears on the selected image.

6 Repeat step 5 to mark other images.

7 Press MENU.

8 Select [OK] with ►, then press ●.
   The ✁ mark turns white.

To cancel, select [Cancel] in step 4 or select [Exit] in step 8, then press ●.

To remove the mark in index mode
Select the images from which you want to remove the mark in step 5, then press ●.

To remove all the marks in the folder
Select [All In This Folder] in step 4, then press ●. Select [Off], then press ●.
You can view images on a TV screen by connecting the camera to a TV.

Turn off both your camera and the TV before connecting the camera and the TV.

1 Connect the camera to the TV.

- Place the camera with the screen facing upwards.

- If your TV has stereo input jacks, connect the audio plug (black) of the cable for multi-use terminal to the left audio jack.

2 Turn on the TV and set the TV/video input switch to “video.”

- For details, see the operating instructions supplied with the TV.

3 Press ▶ to turn on the camera.

Images shot with the camera appear on the TV screen.

Press ◄/▶ on the control button to select the desired image.

- When using your camera abroad, it may be necessary to switch the video signal output to match that of your TV system (page 57).
**Connecting your camera to your TV**

**On TV color systems**

If you want to view images on a TV screen, you need a TV with a video input jack and the cable for multi-use terminal. The color system of the TV must match that of your digital still camera. Check the following lists for the TV color system of the country or region where the camera is used.

**NTSC system**

Bahama Islands, Bolivia, Canada, Central America, Chile, Colombia, Ecuador, Jamaica, Japan, Korea, Mexico, Peru, Surinam, Taiwan, the Philippines, the U.S.A., Venezuela, etc.

**PAL system**

Australia, Austria, Belgium, China, Czech Republic, Denmark, Finland, Germany, Holland, Hong Kong, Hungary, Italy, Kuwait, Malaysia, New Zealand, Norway, Poland, Portugal, Singapore, Slovak Republic, Spain, Sweden, Switzerland, Thailand, United Kingdom, etc.

**PAL-M system**

Brazil

**PAL-N system**

Argentina, Paraguay, Uruguay

**SECAM system**

Bulgaria, France, Guiana, Iran, Iraq, Monaco, Russia, Ukraine, etc.
If you experience trouble with your camera, try the following solutions.

1. **Check the items on pages 83 to 93.**
   If a code such as “C/E:□□:□□□” appears on the screen, see page 94.

2. **Remove the battery pack, and insert the battery pack again after about one minute, and turn on the power.**

3. **Initialize the settings (page 55).**

4. **Consult your Sony dealer or local authorized Sony service facility.**

Please understand that you give your consent that the contents of the internal memory may be checked when you send your camera to be repaired.
Battery pack and power

The battery pack cannot be installed.
- As you insert the battery pack, use the tip of the battery pack to push the battery eject lever toward the lens (→ step 1 in “Read This First”).
- Install the battery pack correctly (→ step 1 in “Read This First”).

The battery remaining indicator is incorrect, or sufficient battery remaining indicator is displayed but the power runs out too quickly.
- This phenomenon occurs when you use the camera in an extremely hot or cold location (page 99).
- The displayed battery remaining differs from the current one. Fully discharge and then charge the battery pack to correct the display.
- The battery pack is discharged. Install the charged battery pack (→ step 1 in “Read This First”).
- The battery pack is dead (page 99). Replace it with a new one.

The battery pack runs down too quickly.
- Charge it sufficiently (→ step 1 in “Read This First”).
- You are using the camera in an extremely cold location (page 99).
- The battery terminal is dirty. Clean the battery terminal with a cotton swab, etc., and charge the battery pack.
- The battery pack is dead (page 99). Replace it with a new one.

Cannot turn on the camera.
- Install the battery pack correctly (→ step 1 in “Read This First”).
- The battery pack is discharged. Install charged battery pack (→ step 1 in “Read This First”).
- The battery pack is dead (page 99). Replace it with a new one.

The power turns off suddenly.
- If you do not operate the camera for about three minutes while the power is on, the camera turns off automatically to prevent wearing down the battery pack. Turn on the camera again (→ step 2 in “Read This First”).
- The battery pack is discharged. Install charged battery pack (→ step 1 in “Read This First”).


**Shooting still images/movies**

The screen does not turn on even when the power is turned on.

- Turn on the screen (page 24).

Your camera cannot record images.

- Check the free capacity of the internal memory or “Memory Stick Duo” (page 25). If it is full, do one of the following:
  - Delete unnecessary images (→ step 6 in “Read This First”).
  - Change the “Memory Stick Duo”.
- You are using the “Memory Stick Duo” with the write-protect switch, and the switch is set to the LOCK position. Set the switch to the recording position (page 97).
- You cannot record images while charging the flash.
- When shooting a still image, set the mode dial to a position other than 📸.
  - Set the mode dial to 📸 when shooting movies.
- The image size is set to [640(Fine)] when recording movies. Do one of the following:
  - Set the image size to other than [640(Fine)].
  - Insert a “Memory Stick PRO Duo” (page 97).

The subject is not visible on the screen.

- Your camera is set to the Playback mode. Press the shutter button halfway down, change the position of the mode dial, or press 📸 to change to the recording mode (→ step 6 in “Read This First”).

Recording takes a long time.

- The NR slow shutter function is activated (page 21). This is not a malfunction.

The image is out of focus.

- The subject is too close. Record in the close-up (Macro) recording mode. Make sure to position the lens farther away from the subject than the shortest shooting distance, approximately 6 cm (2 3/8 inches) (W)/30 cm (11 7/8 inches) (T), when shooting. (→ step 5 in “Read This First”).
- 🌃 (Twilight mode) or 🌋 (Landscape mode) is selected in the Scene mode when shooting still images.
- The Focus preset function is selected. Select the auto focus mode (page 35).
- Refer to “If the subject is out of focus” on page 36.

Optical zoom does not work.

- You cannot change the zoom scale when shooting movies.

Precision digital zoom does not function.

- Set [Digital Zoom] to [Precision] (page 49).
- This function cannot be used while shooting movies.
Smart zoom does not function.
- Set [Digital Zoom] to [Smart] (page 49).
- This function cannot be used when:
  - The image size is set to [8M] or [3:2].
  - Shooting in Multi Burst mode.
  - Shooting movies.

The flash does not work.
- The flash is set to \(\) (Flash forced off) (→ step 5 in “Read This First”).
- You cannot use the flash when:
  - [Mode] (REC Mode) is set to [Burst] or [Multi Burst] (page 38).
  - \(\) (High sensitivity mode) or \(\) (Twilight mode) is selected in the Scene Selection.
  - When the mode dial is set to \(\).
- Set the flash to \(\) (Flash forced on) when \(\) (Landscape mode) or \(\) (Beach mode) is selected in the Scene Selection.

Fuzzy specks appear in images shot using the flash.
- Dust in the air reflected the flash light and appeared in the image. This is not a malfunction.

The close-up (Macro) function does not work.
- \(\) (Twilight mode) or \(\) (Landscape mode) is selected in the Scene Selection (page 30).

The date and time are not displayed.
- While shooting, the date and time are not displayed. Only during playback, the date and time are displayed.

The date and time are recorded incorrectly.
- Set the correct date and time (→ step 2 in “Read This First”).

The F value and shutter speed flash when you press and hold the shutter button halfway down.
- The exposure is incorrect. Correct the exposure (page 30, → step 5 in “Read This First”).

The image is too dark.
- You are shooting a subject with a light source behind the subject. Select the metering mode (page 36) or adjust the exposure (page 30, → step 5 in “Read This First”).
- When the brightness of the screen is too low, adjust the brightness of the LCD backlight (page 24, → step 5 in “Read This First”).
- Turn on the screen (page 24).
The image is too bright.

- You are shooting a spotlighted subject in a dark location such as on a stage. Adjust the exposure (page 30, \textit{step 5 in “Read This First”}).
- When the brightness of the screen is too high, adjust the brightness of the LCD backlight (page 24, \textit{step 5 in “Read This First”}).

The image colors are not correct.

- Adjust the [Color Mode] to [Normal] (page 34).

Vertical streaks appear when you are shooting a very bright subject.

- The smear phenomenon is occurring. This phenomenon is not a malfunction.

Noise appears in the image when you view the screen in a dark place.

- The camera is attempting to increase the visibility of the screen by temporarily brightening the image under conditions of low illumination. There is no effect on the recorded image.

The eyes of the subject come out red.

- Shoot the subject at a distance closer than the recommended shooting distance using the flash (\textit{→ step 5 in “Read This First”}).
- Light the room and shoot the subject.

Dots appear and remain on the screen.

- This is not a malfunction. These dots are not recorded (page 8, \textit{→ “Read This First”}).

The image seen through the finder does not indicate the actual recordable range.

- The parallax phenomenon is occurring when the subject is close. To confirm the recordable range, use the LCD screen.

Cannot shoot images in succession.

- The internal memory or “Memory Stick Duo” is full. Delete unnecessary images (\textit{→ step 6 in “Read This First”}).
- The battery level is low. Install charged battery pack.

Viewing images

Refer to “Computers” (page 88) in conjunction with the following items.
Your camera cannot play back images.

- Press (→ step 6 in “Read This First”).
- The folder/file name has been changed on your computer (page 67).
- When an image file has been processed by a computer or when the image file was recorded using a model other than that of your camera, playback on your camera is not guaranteed.
- The camera is in USB mode. Delete the USB connection (page 65).

The date and time are not displayed.

- (Screen display switch) button is turned off (page 24).

The image appears rough right after playback starts.

- The image may appear rough right after playback starts due to image processing. This is not a malfunction.

Color unevenness may appear during video playback.

- This is not a malfunction. The recorded images are not affected.

Images are not displayed on the screen.

- Remove the cable for multi-use terminal if the cable is connected (page 80).

The image does not appear on the TV screen.

- Check [Video Out] to see if the video output signal of your camera is set to the color system of your TV (page 57).
- Check whether the connection is correct (page 80).
- When the cable for multi-use terminal is connected to the USB jack, remove the cable.

Deleting/Editing images

Your camera cannot delete an image.

- Cancel the protection (page 43).
- You are using the “Memory Stick Duo” with the write-protect switch, and the switch is set to the LOCK position. Set the switch to the recording position (page 97).

You have deleted an image by mistake.

- Once you have deleted an image, you cannot restore it. We recommend that you protect images (page 42), or use the “Memory Stick Duo” with the write-protect switch and set the switch to the LOCK position (page 97) to prevent accidental erasure.

The resizing function does not work.

- You cannot resize movies and Multi Burst images.
You cannot display a DPOF (Print order) mark.
  • You cannot display DPOF (Print order) marks on movies.

You cannot cut a movie.
  • The movie is not long enough to cut (shorter than about two seconds).
  • Cancel the protection (page 43).
  • Still images cannot be cut.

Computers

You do not know if the OS of your computer is compatible with the camera.
  • Check “Recommended computer environment” on page 59 for Windows, and page 72 for Macintosh.

Your computer does not recognize your camera.
  • Turn on the camera (→ step 2 in “Read This First”).
  • When the battery level is low, install the charged battery pack (→ step 1 in “Read This First”), or use the AC Adaptor (page 19).
  • Use the cable for multi-use terminal (supplied) (page 62).
  • Disconnect the cable for multi-use terminal, and connect it again firmly. Make sure that “USB Mode Mass Storage” is displayed (page 62).
  • Set [USB Connect] to [Mass Storage] in the (Setup) menu (page 56).
  • Disconnect all equipment other than the camera, the keyboard and the mouse from the USB jacks of your computer.
  • Connect the camera directly to your computer without passing through a USB hub or other device (page 62).
  • The software (supplied) is not installed. Install the software (page 60).
  • Your computer does not properly recognize the device because you connected the camera and your computer with the cable for multi-use terminal before you installed the software (supplied). Delete the erroneously recognized device from your computer, then install the software (see the next item).

The “Removable disk” icon does not appear on the computer screen when you connect your computer to the camera.
  • Follow the procedure below to install the USB driver again. The following procedure is for a Windows computer.
  1 Right-click [My Computer] to display the menu, then click [Properties].
     The “System Properties” screen appears.
  2 Click [Hardware] → [Device Manager].
     • For Windows Me, click the [Device Manager] tab.
     The “Device Manager” appears.
  3 Right-click [Sony DSC], then click [Uninstall] → [OK].
     The device is deleted.
4 Install the software (page 60).
   The USB driver is also installed automatically.

You cannot copy images.
   • Connect the camera and your computer correctly. Make the USB connection by properly connecting the camera with your computer (page 62).
   • Follow the designated copy procedure for your OS (pages 62, 72).
   • When you shoot images with a “Memory Stick Duo” formatted by a computer, you may not be able to copy the images to a computer. Shoot using a “Memory Stick Duo” formatted by your camera (page 53).

After making a USB connection, “Cyber-shot Viewer” does not start automatically.
   • Start “Media Check Tool” (page 68).
   • Make the USB connection after the computer is turned on (page 62).

The image cannot be played back on a computer.
   • If you are using “Cyber-shot Viewer,” refer to the Help.
   • Consult the computer or software manufacturer.

The image and sound are interrupted by noise when you view a movie on a computer.
   • You are playing back the movie directly from the internal memory or the “Memory Stick Duo”. Copy the movie to the hard disk of your computer, then play back the movie from the hard disk (page 61).

You cannot print an image.
   • Check the printer settings.

Images once copied to a computer cannot be viewed on the camera.
   • Copy them to a folder recognized by the camera, such as “101MSDCF” (page 66).
   • Operate correctly (page 67).

“Cyber-shot Viewer”

Images are not displayed correctly.
   • Make sure the folder of the images is registered in “Viewed folders”. If the images are not displayed even if the folder is registered in “Viewed folders”, update the database (page 71).

You cannot find images imported.
   • Look in the “My Pictures” folder.
• If you have changed the default settings, refer to “Changing the “Folder to be imported”” on page 71 and check what folder is used for importing.

You want to change the “Folder to be imported”.
• Access the “Import Settings” screen to change “Folder to be imported”. You can specify a different folder after using “Cyber-shot Viewer” to register it in “Viewed folders” (page 71).

All imported images are displayed on the calendar with the date January 1.
• The date has not been set on the camera. Set the date on the camera (→ step 2 in “Read This First”).

“Memory Stick Duo”

Cannot insert a “Memory Stick Duo”.
• Insert it in the correct direction (→ step 3 in “Read This First”).

Cannot record on a “Memory Stick Duo”.
• You are using the “Memory Stick Duo” with the write-protect switch, and the switch is set to the LOCK position. Set the switch to the recording position (page 97).
• The “Memory Stick Duo” is full. Delete unnecessary images (→ step 6 in “Read This First”).
• Insert a “Memory Stick PRO Duo” (page 26) when recording movies with the image size set to [640(Fine)].

Cannot format a “Memory Stick Duo”.
• You are using the “Memory Stick Duo” with the write-protect switch, and the switch is set to the LOCK position. Set the switch to the recording position (page 97).

You have formatted a “Memory Stick Duo” by mistake.
• All the data on the “Memory Stick Duo” is deleted by formatting. You cannot restore it. We recommend that you set the write-protect switch on the “Memory Stick Duo” to the LOCK position to prevent accidental erasure (page 97).

“Memory Stick PRO Duo” is not recognized by a computer with a “Memory Stick” slot.
• Check whether the computer and the card reader support “Memory Stick PRO Duo”. Users of computers and card readers made by companies other than Sony should contact those manufacturers.
• If “Memory Stick PRO Duo” is not supported, connect the camera to the computer (page 62). The computer recognizes the “Memory Stick PRO Duo”.
Internal memory

The camera or your computer cannot play back the data in the internal memory.

- There is a “Memory Stick Duo” inserted in the camera. Remove it (→ step 4 in “Read This First”).

Cannot record images using the internal memory.

- There is a “Memory Stick Duo” inserted in the camera. Remove it (→ step 4 in “Read This First”).

The free capacity of the internal memory does not increase even when you copy the data stored in the internal memory to a “Memory Stick Duo”.

- The data is not deleted after copying. Execute the [Format] command (page 52) to format the internal memory after copying the data.

Cannot copy the data stored in the internal memory to a “Memory Stick Duo”.

- The “Memory Stick Duo” is full. Check the capacity (64 MB or more recommended).

Cannot copy the data on the “Memory Stick Duo” or the computer to the internal memory.

- Data on a “Memory Stick Duo” or a computer cannot be copied to the internal memory.

Printing

Also see “PictBridge compliant printer” (as follows) in conjunction with the following items.

Images are printed with both edges cut off.

- When you print an image shot with the image size set to [16:9], both edges of the image may be cut off.
- When printing images using your own printer, try canceling the trimming or borderless settings. Consult the printer manufacturer as to whether the printer provides these functions or not.
- When having images printed at a digital print shop, ask the shop whether they can print the images without cutting off both edges.

PictBridge compliant printer

A connection cannot be established.

- The camera cannot be connected directly to a printer that is not compliant with the PictBridge standard. Consult the printer manufacturer as to whether the printer is compliant with PictBridge or not.
- Check that the printer is turned on and can be connected to the camera.
- Set [USB Connect] to [PictBridge] in the (Setup) menu (page 56).
• Disconnect the cable for multi-use terminal, and connect it again. If an error message is indicated on the printer, refer to the operating instructions supplied with the printer.

Cannot print images.
• Check the cable for multi-use terminal is connected correctly.
• Turn on the printer. For further information, refer to the operating instructions supplied with the printer.
• If you select [Exit] during printing, images may not print. Disconnect and connect the cable for multi-use terminal again. If you still cannot print your images, disconnect the cable, turn the printer off and then on, then connect the cable again.
• Movies cannot be printed.
• Images shot using cameras other than this camera or images modified with a computer may not be printed.

Printing is canceled.
• You disconnected the cable for multi-use terminal before the (PictBridge Connecting) mark disappears.

Cannot insert the date or print images in the index mode.
• The printer does not provide these functions. Consult the printer manufacturer as to whether the printer provides these functions or not.
• The date may not be inserted in the index mode depending on the printer. Consult the printer manufacturer.

“---- -- --” is printed on the date-inserted part of the image.
• Images that do not have the recording data cannot be printed with the date inserted. Set [Date] to [Off] and print the image again (page 77).

Cannot select the print size.
• Consult the printer manufacturer as to whether the printer can provide the desired size.

Cannot print the image at the size selected.
• If you have changed the paper size after having the cable for multi-use terminal connected, then connect the printer again.
• The print setting of the camera differs from that of the printer. Change the setting of either the camera (page 77) or the printer.

Cannot operate the camera after canceling printing.
• Wait for a while as the printer is carrying out the cancellation. It may take some time depending on the printer.
Others

Your camera does not work.

- Use the type of battery pack you can use with this camera.
- The battery level is low (The \( \infty \) indicator appears). Charge the battery pack (→ step 1 in “Read This First”).

The power is on, but the camera does not work.

- The built-in microcomputer is not working properly. Remove the battery pack, and then, after one minute, insert the battery pack and turn on the camera.

Cannot identify an indicator on the screen.

- See page 20.

The lens gets fogged.

- Moisture condensation has occurred. Turn off the camera and leave it for about an hour before using it (page 101).

The camera becomes warm when you use it for a long time.

- This is not a malfunction.

The lens does not move when you turn off the camera.

- The battery pack is discharged. Replace it with a charged battery pack (→ Step 1 in “Read This First”) or use the AC Adaptor (not supplied).

The Clock Set screen appears when you turn on the camera.

- Set the date and time again (→ step 2 in “Read This First”).
Warning indicators and messages

Self-diagnosis display
If a code starting with a letter of the alphabet appears, your camera has a self-diagnosis display. The last two digits (indicated by □□) will differ depending on the state of the camera.
If you are unable to solve the problem even after trying the following corrective actions a few times, your camera may need repair. Contact your Sony dealer or local authorized Sony service facility.

C:32:□□
• There is trouble with your camera’s hardware. Turn the power off and on again.

C:13:□□
• The camera cannot read or write data on the “Memory Stick Duo”. Either turn off and on the camera or re-insert the “Memory Stick Duo” several times.
• The internal memory has experienced a format error, or an unformatted “Memory Stick Duo” is inserted. Format the internal memory or the “Memory Stick Duo” (pages 52, 53).
• The inserted “Memory Stick Duo” cannot be used with your camera, or the data is damaged. Insert a new “Memory Stick Duo” (page 97).

E:61:□□

E:91:□□
• A camera malfunction has occurred. Initialize the camera (page 55), then turn the power on again.

Messages
If the following messages appear, follow the instructions.

• The battery level is low. Charge the battery pack immediately (→ step 1 in “Read This First”). Depending on the conditions of use or the type of battery pack, the indicator may flash even though there are still 5 to 10 minutes of remaining battery time left.

For use with compatible battery only
• The battery inserted is not an NP-BG1 battery pack.

System error
• Turn the power off and then on again (→ step 2 in “Read This First”).

Internal memory error
• Turn the power off and then on again (→ step 2 in “Read This First”).

Reinsert the Memory Stick
• Insert the “Memory Stick Duo” correctly.
• The inserted “Memory Stick Duo” cannot be used in your camera (page 97).
• The “Memory Stick Duo” is damaged.
• The terminal section of the “Memory Stick Duo” is dirty.

Memory Stick type error
• The inserted “Memory Stick Duo” cannot be used in your camera (page 97).

Format error
• Format the media again (pages 52, 53).
Troubleshooting

Memory Stick locked
- You are using the “Memory Stick Duo” with the write-protect switch, and the switch is set to the LOCK position. Set the switch to the recording position (page 97).

No memory space in internal memory
No memory space in Memory Stick
- Delete unnecessary images or files (→ step 6 in “Read This First”).

Read only memory
- Your camera cannot record or delete images on this “Memory Stick Duo”.

No file
- No images have been recorded in the internal memory.

No file in this folder
- No images have been recorded in this folder.
- You did not operate correctly when copying images from your computer (page 67).

Folder error
- A folder with the same first three digit number already exists on the “Memory Stick Duo” (For example: 123MSDCF and 123ABCDE). Select another folders, or create a new folder (page 53).

Cannot record
- The camera cannot record images in the selected folder. Select a different folder (page 54).

File error
- An error occurred while the image was playing back.

File protect
- Release the protection (page 43).

Image size over
- You are playing back an image of a size that cannot be played back on your camera.

Cannot divide
- The movie is not long enough to be divided (shorter than about two seconds).
- The file is not a movie.

Invalid operation
- You are trying to play back a file that is not compatible with the camera.

(Vibration warning indicator)
- Camera shake may occur due to insufficient light. Use the flash or mount the camera on a tripod to secure the camera.

640(Fine) is not available
- 640(Fine) size movies can be recorded only using a “Memory Stick PRO Duo”. Insert a “Memory Stick PRO Duo” or set the image size to a size other than [640(Fine)].
Enable printer to connect

- [USB Connect] is set to [PictBridge], however the camera is connected to a non-PictBridge compliant device. Check the device.
- The connection is not established. Disconnect the cable for multi-use terminal, and connect it again. If an error message is indicated on the printer, refer to the operating instructions supplied with the printer.

Connect to PictBridge device

- You tried to print images before the printer connection was established. Connect to a PictBridge compliant printer.

No printable image

- You tried to execute [DPOF image] without placing a DPOF (Print order) mark on the image(s).
- You tried to execute [All In This Folder] while a folder that holds only movies was selected. You cannot print movies.

Printer busy

- The printer is canceling the current print job. You cannot print until it is finished. This may take time, depending on the printer.

Paper error

- Check the printer.

No Paper

- Check the printer.

Ink error

- Check if the image you want to print is corrupted.

Low Ink

- Check the printer.

No Ink

- Check the printer.

Processing

- The data transmission to the printer may not be completed yet. Do not disconnect the cable for multi-use terminal.
On the “Memory Stick”

A “Memory Stick” is a compact, portable IC recording medium. The types of “Memory Stick” that can be used with this camera are listed in the table below. However, proper operation cannot be guaranteed for all “Memory Stick” functions.

<table>
<thead>
<tr>
<th>“Memory Stick” type</th>
<th>Recording/Playback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Memory Stick (without MagicGate)</td>
<td>—</td>
</tr>
<tr>
<td>Memory Stick (with MagicGate)</td>
<td>—</td>
</tr>
<tr>
<td>Memory Stick Duo (without MagicGate)</td>
<td>○</td>
</tr>
<tr>
<td>Memory Stick Duo (with MagicGate)</td>
<td>○<em>1</em>2</td>
</tr>
<tr>
<td>MagicGate Memory Stick</td>
<td>—</td>
</tr>
<tr>
<td>MagicGate Memory Stick Duo</td>
<td>○*1</td>
</tr>
<tr>
<td>Memory Stick PRO</td>
<td>—</td>
</tr>
<tr>
<td>Memory Stick PRO Duo</td>
<td>○<em>1</em>2*3</td>
</tr>
</tbody>
</table>

*1 “Memory Stick Duo”, “MagicGate Memory Stick Duo” and “Memory Stick PRO Duo” are equipped with MagicGate functions. MagicGate is copyright protection technology that uses encryption technology. Data recording/playback that requires MagicGate functions cannot be performed with this camera.

*2 Supports high-speed data transfer using a parallel interface.

*3 640(Fine) size movies can be recorded.

Notes on using a “Memory Stick Duo” (not supplied)

- You cannot record, edit or delete images if you slide the write-protect switch to LOCK with a fine-tipped object.

Some “Memory Stick Duo” cards do not have a write-protect switch. On “Memory Stick Duo” with this switch, the position and shape may vary depending on the “Memory Stick Duo”.

- Do not remove the “Memory Stick Duo” while reading or writing data.
- Data may be corrupted in the following cases:
  - When the “Memory Stick Duo” is removed or the camera is turned off during a read or write operation
  - When the “Memory Stick Duo” is used in locations subject to static electricity or electrical noise
- We recommend backing up important data.
- Do not press down hard when you write down on the memo area.
- Do not attach a label on the “Memory Stick Duo” itself nor on a Memory Stick Duo Adaptor.
- When you carry or store the “Memory Stick Duo”, put it in the case supplied with it.
- Do not touch the terminal section of the “Memory Stick Duo” with your hand or a metal object.
- Do not strike, bend or drop the “Memory Stick Duo”.
- Do not disassemble or modify the “Memory Stick Duo”.
- Do not expose the “Memory Stick Duo” to water.
- Do not leave the “Memory Stick Duo” within the reach of small children. They might accidentally swallow it.
• Do not use or store the “Memory Stick Duo” under the following conditions:
  – High temperature locations such as the hot interior of a car parked in direct sunlight
  – Locations exposed to direct sunlight
  – Humid locations or locations with corrosive substances present

Notes on using the Memory Stick Duo Adaptor (not supplied)

• To use a “Memory Stick Duo” with a “Memory Stick” compliant device, be sure to insert the “Memory Stick Duo” into a Memory Stick Duo Adaptor. If you insert a “Memory Stick Duo” into a “Memory Stick” compliant device without a Memory Stick Duo Adaptor, you might not be able to remove it from the device.

• When inserting a “Memory Stick Duo” into a Memory Stick Duo Adaptor, make sure the “Memory Stick Duo” is inserted facing in the correct direction, then insert it all the way in. Incorrect insertion may result in a malfunction.

• When using a “Memory Stick Duo” inserted into a Memory Stick Duo Adaptor with a “Memory Stick” compliant device, make sure that the Memory Stick Duo Adaptor is inserted facing the correct direction. Note that improper use may damage the equipment.

• Do not insert a Memory Stick Duo Adaptor into a “Memory Stick” compliant device without a “Memory Stick Duo” attached. Doing so may result in malfunction of the unit.

Notes on using “Memory Stick PRO Duo” (not supplied)

“Memory Stick PRO Duo” with a capacity up to 2 GB have been confirmed to operate properly with this camera.
On the battery pack

On charging the battery pack
We recommend charging the battery pack in an ambient temperature of between 10°C to 30°C (50°F to 86°F). You may not be able to efficiently charge the battery pack outside of this temperature range.

Effective use of the battery pack
- Battery performance decreases in low temperature surroundings. So, the time that the battery pack can be used is shorter in cold places. We recommend the following to ensure longer battery pack use:
  - Put the battery pack in a pocket close to your body to warm it up, and insert it in your camera immediately before you start shooting.
- The battery pack will run out quickly if you use the flash or zoom frequently.
- We recommend having spare battery packs handy for two or three times the expected shooting time, and making trial shots before taking the actual shots.
- Do not expose the battery pack to water. The battery pack is not water-resistant.
- Do not leave the battery pack in extremely hot places, such as in a car or under direct sunlight.

How to store the battery pack
- If the battery pack is not to be used for a long time, fully charge it and then fully use it up once a year on your camera before storing the battery pack in a dry, cool place. Repeat this charging and using up once a year to maintain the battery pack’s function.
- To use the battery pack up, leave your camera in slide show playback mode (page 43) until the power goes off.
- To prevent staining the terminal, short-circuiting, etc., be sure to use a supplied battery case when carrying and storing.

On battery life
- The battery life is limited. Battery capacity decreases little by little as you use it more and more, and as time passes. If the battery operating time seems shortened considerably, a probable cause is that the battery pack has reached the end of its life. Buy a new battery pack.
- The battery life varies according to how it is stored and the operating conditions and environment in which each battery pack is used.
**On the battery charger**

- Do not charge any battery pack other than the supplied NP-BG type battery packs in the battery charger (supplied) with your camera. Batteries other than the specified kind may leak, overheat, or explode if you attempt to charge them, posing a risk of injury from electrocution and burns.

- Remove the charged battery pack from the battery charger. If you leave the charged battery pack in the charger, battery life may be decreased.

- When the CHARGE lamp flashes, this may indicate a battery error or that a battery pack other than the specified type have been inserted. Check that the battery pack is the specified type. If the battery pack is the specified type, remove the battery pack, replace it with new one or another one and check if the battery charger operates correctly. If the battery charger operates correctly, a battery error may have occurred.

- If the battery charger is dirty, charging may not be performed successfully. Clean the battery charger with dry cloth, etc.
Precautions

Do not use/store the camera in the following places

- In an extremely hot, dry or humid place
  In places such as in a car parked in the sun, the camera body may become deformed and this may cause a malfunction.
- Under direct sunlight or near a heater
  The camera body may become discolored or deformed, and this may cause a malfunction.
- In a location subject to rocking vibration
- Near strong magnetic place
- In sandy or dusty places
  Be careful not to let sand or dust get into the camera. This may cause the camera to malfunction, and in some cases this malfunction cannot be repaired.

On carrying

Do not sit down in a chair or other place with the camera in the back pocket of your trousers or skirt, as this may cause malfunction or damage the camera.

On cleaning

Cleaning the LCD screen
Wipe the screen surface with an LCD cleaning kit (not supplied) to remove fingerprints, dust, etc.

Cleaning the lens
Wipe the lens with a soft cloth to remove fingerprints, dust, etc.

Cleaning the camera surface
Clean the camera surface with a soft cloth slightly moistened with water, then wipe the surface with a dry cloth. Do not use the following as they may damage the finish or the casing.
- Chemical products such as thinner, benzine, alcohol, disposable cloths, insect repellent, sunscreen or insecticide, etc.
- Do not touch the camera with the above on your hand.
- Do not leave the camera in contact with rubber or vinyl for a long time.

On operating temperatures

Your camera is designed for use under the temperatures between 0°C and 40°C (32°F and 104°F). Shooting in extremely cold or hot places that exceed this range is not recommended.

On moisture condensation

If the camera is brought directly from a cold to a warm location, moisture may condense inside or outside the camera. This moisture condensation may cause a malfunction of the camera.

Moisture condensation occurs easily when:
- The camera is brought from a cold location such as a ski slope into a warmly heated room.
- The camera is taken from an air-conditioned room or car interior to the hot outdoors, etc.

How to prevent moisture condensation

When bringing the camera from a cold place to a warm place, seal the camera in a plastic bag and allow it to adapt to conditions at the new location over about an hour.

If moisture condensation occurs

Turn off the camera and wait about an hour for the moisture to evaporate. Note that if you attempt to shoot with moisture remaining inside the lens, you will be unable to record clear images.
■ On the internal rechargeable battery

This camera has an internal rechargeable battery for maintaining the date and time and other settings regardless of whether the power is on or off.

This rechargeable battery is continually charged as long as you are using the camera. However, if you use the camera for only short periods, it discharges gradually, and if you do not use the camera at all for about one month it becomes completely discharged. In this case, be sure to charge this rechargeable battery before using the camera.

However, even if this rechargeable battery is not charged, you can still use the camera as long as you do not record the date and time.

Charging method of the internal rechargeable battery

Insert charged battery pack in the camera, or connect the camera to a wall outlet (wall socket) using the AC Adaptor (not supplied), and leave the camera for 24 hours or more with the power off.

Charging method of the battery pack

→ step 1 in “Read This First”
Specifications

**Camera**

**[System]**
- Image device: 9.10 mm (1/1.8 type) color CCD, Primary color filter
- Total pixel number of camera: Approx. 8 303 000 pixels
- Effective pixel number of camera: Approx. 8 068 000 pixels
- Lens: Carl Zeiss Vario-Tessar
  - 3× zoom lens
  - F 7.9 – 23.7 mm (38 – 114 mm when converted to a 35 mm still camera)
  - F 2.8 – 5.2
- Exposure control: Automatic exposure, Manual exposure, Scene Selection (6 modes)
- White balance: Automatic, Daylight, Cloudy, Fluorescent, Incandescent, Flash
- File format (DCF compliant):
  - Still images: Exif Ver. 2.21, JPEG compliant, DPOF compatible
  - Movies: MPEG1 compliant (Monaural)
- Recording media: Internal Memory (64 MB)
- Flash: Recommended distance (ISO set to Auto): approx. 0.2 m to 6 m (7 7/8 inches to 19 feet 8 7/8 inches) (W)/approx. 0.3 m to 3.2 m (11 7/8 inches to 10 feet 6 3/8 inches) (T)

**[Input and Output connectors]**
- Multi connector
- USB communication: Hi-Speed USB (USB 2.0 compliant)

**[LCD screen]**
- LCD panel: 6.2 cm (2.5 type) TFT drive
- Total number of dots: 115 200 (480 × 240) dots

**[Power, general]**
- Power: Rechargeable battery pack NP-BG1, 3.6 V
  - AC-LS5K AC Adaptor (not supplied), 4.2 V
- Power consumption (during shooting with the LCD screen on): 0.95 W
- Operating temperature: 0 to 40°C (32 to 104°F)
- Storage temperature: –20 to +60°C (–4 to +140°F)
- Dimensions: 94.2 × 60.6 × 24.8 mm (3 3/4 inches × 2 1/2 inches × 1 inch) (W/H/D, excluding protrusions)
- Mass: Approx. 192 g (6.8 oz)
- Microphone: Electret condenser microphone
- Speaker: Dynamic speaker
- Exif Print: Compatible
- PRINT Image Matching III: Compatible
- PictBridge: Compatible

**BC-CSG battery charger**
- Power requirements: AC 100 to 240 V, 50/60 Hz, 2 W
- Output voltage: DC 4.2 V, 0.25 A
- Operating temperature: 0 to 40°C (32 to 104°F)
- Storage temperature: –20 to +60°C (–4 to +140°F)
- Dimensions: Approx. 62 × 24 × 91 mm (2 1/2 × 3 1/32 × 3 5/8 inches) (W/H/D)
- Mass: Approx. 75 g (2.7 oz)

**Rechargeable battery pack NP-BG1**
- Used battery: Lithium-ion battery
- Maximum voltage: DC 4.2 V
- Nominal voltage: DC 3.6 V
- Capacity: 3.6 Wh (960 mAh)

Design and specifications are subject to change without notice.
A

AC Adaptor...........................19
   → step 1 in “Read This First”
Accessories supplied
   → in “Read This First”
AE/AF lock indicator ...........36
   → step 5 in “Read This First”
AF Illuminator....................51
AF lock .................................36
AF Mode...............................49
AF range finder frame ..........35
AF range finder frame
   indicator.........................35
Aperture................................14
   → step 5 in “Read This First”
Auto adjustment mode
   → step 5 in “Read This First”
Auto Focus............................13
Auto power-off function
   → step 2 in “Read This First”
Auto Review .........................51

B

B&W ....................................34
Backlight
   → step 5 in “Read This First”
Battery charger ..................100
   → step 1 in “Read This First”
Battery pack........................99
   Battery life.......................28
Charging
   → step 1 in “Read This First”
Insert/Remove
   → step 1 in “Read This First”
Remaining indicator
   → step 1 in “Read This First”
Beach mode
   → step 5 in “Read This First”
Beep .......................................55
   → step 5 in “Read This First”
Blur ........................................13
Brightness of image ..........14
Burst.....................................38

C

Cable for multi-use terminal
   ................... 62, 76, 80
Camera .................................49
   → step 5 in “Read This First”
CD-ROM.............................. 49
Center AF...........................60
Center-weighted metering....35
Change REC. Folder ..........36
Charging battery pack
   → step 1 in “Read This First”
Cleaning .........................101
Clock Set..............................57
Cloudy ..................................37
Color .....................................16
Color Mode..........................34
Compression ratio ..............17
Computer .........................58
   → step 6 in “Read This First”
   Copy images to your
   computer .......................61
Create REC. Folder ..........53
Cyber-shot Viewer.............68

D

Daylight............................37
DC IN jack .........................19
Delete
   → step 6 in “Read This First”
Digital Zoom ......................49
Divide..................................45
DPOF..................................78

E

Effective pixels ................103
Electronic transformer
   → step 1 in “Read This First”
Exposure ............................14
Extension .........................66, 67

F

File name .............................66
File Number........................56
File storage destination .....66
Fine .....................................38
Flash ....................................37
Flash forced off
   → step 5 in “Read This First”
Flash forced on
   → step 5 in “Read This First”
Flash Level ..........................40
Flash mode
   → step 5 in “Read This First”
Fluorescent........................37
Focus ..................................13, 35
Resize ...................................44
Rewind/Fast forward  
→ step 6 in “Read This First”
Rotate ...................................45

S
S AF ......................................49
Scene Selection .....................30  
→ step 5 in “Read This First”
Screen
Changing the display .........24
Indicator .........................20
LCD Backlight ..............55
Self-diagnosis display ........94
Self-timer  
→ step 5 in “Read This First”
Sepia .................................34
Set the clock  
→ step 2 in “Read This First”
Setup .................................40, 47, 48
Camera ..............................49
Internal Memory Tool...52
Memory Stick Tool ....53
Setup 1 ...............................55
Setup 2 ...............................56
Setup 1 ................................55
Setup 2 ................................56
Sharpness ............................40
Shooting
Movie  
→ step 5 in “Read This First”
Still image  
→ step 5 in “Read This First”
Shooting menu ..................34
Shooting movies  
→ step 5 in “Read This First”
Shutter speed .....................14
Single ..............................49
Single-image mode printing ....75
Slow synchro  
→ step 5 in “Read This First”
Smart zoom .......................49
Soft snap mode  
→ step 5 in “Read This First”
Software ..........................68
Specifications .................103
Spot metering ....................36
Spot metering cross hairs.....36
Standard ...........................38
Trimming ...........................47
Troubleshooting ...............82
TV ........................................80
Twilight mode  
→ step 5 in “Read This First”
Twilight portrait mode  
→ step 5 in “Read This First”
Underexposure ..................14
USB Connect ......................56
Using your camera abroad  
→ step 1 in “Read This First”
VGA  
→ step 4 in “Read This First”
Video Out ..........................57
Warning indicators and messages ....94
White balance ...................37
Windows computer .........58
Recommended environment ...59
Wrist strap  
→ in “Read This First”
Write-protect switch .........97
Zoom  
→ step 5 in “Read This First”
White balance ..................37
Trademarks

- **Cyber-shot** is trademarks of Sony Corporation.
- “Memory Stick”, “Memory Stick PRO”,
  **MEMORY STICK PRO**, “Memory Stick Duo”,
  **MEMORY STICK DUO**, “Memory Stick PRO Duo”, “MagicGate”,
  and **MAGICGATE** are trademarks of Sony Corporation.
- Microsoft, Windows are either registered trademarks or trademarks of Microsoft Corporation in the United States and/or other countries.
- Macintosh and Mac OS are trademarks or registered trademarks of Apple Computer, Inc.
- Intel, MMX, and Pentium are trademarks or registered trademarks of Intel Corporation.
- In addition, system and product names used in this manual are, in general, trademarks or registered trademarks of their respective developers or manufacturers. However, the ™ or ® marks are not used in all cases in this manual.